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Contact Us!

Oracle8i Parallel Server Administrator’s Guide, Release 2 (8.1.6) for Windows NT

Part No.  A73025-01

This document describes how to contact Oracle Corporation if you have issues with the 
documentation or software. It also provides a list of useful resources for Oracle partners and 
developers.

 

How to Contact Oracle Technical Publications
Oracle Corporation welcomes your comments and suggestions on the quality and usefulness of this 
publication. Your input is an important part of the information used for revision.

■ Did you find any errors?
■ Is the information clearly presented?
■ Do you need more information? If so, where?
■ Are the examples correct? Do you need more examples?
■ What features did you like most about this guide?
■ Do you have suggestions for improvement? Please indicate the chapter, section, and page 

number (if available). 
You can send comments regarding documentation to ntdoc@us.oracle.com.

Read the section... If you...

"How to Contact Oracle Technical Publications" on page vii Have issues with Documentation

"How to Contact Oracle Support Services" on page viii Have issues with Software

"Resources for Oracle Partners and Developers" on page xiii Want to join an Oracle partner or application 
developer program
vii



How to Contact Oracle Support Services
Please copy this form and distribute within your organization as necessary.

Oracle Support Services can be reached at the following telephone numbers and Web sites. The hours 
of business are detailed in your support contract and the Oracle Customer Support Guide in your kit.

Please complete the following checklist before you call. If you have this information ready, your call 
can be processed much quicker.

❏ Your CPU Support Identification Number (CSI Number) if applicable.

❏ The hardware name on which your application is running. 

Oracle Support 
Services In... Call...

United States of 
America

+ (650) 506-1500 for customers with support contracts.

+ (650) 506-5577 to obtain a support contract.

Europe +44 1344 860 160 or the local support center in your country.

All other 
locations

The telephone number for your country listed at the following Web site:

http://www.oracle.com/support/contact_us/sup_hot_
phone.html

Oracle Support Services telephone numbers are also listed in the Oracle 
Customer Support Guide in your kit.
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❏ The operating system name and release number on which your application is 
running.

■ To verify the operating system version on Windows NT, enter the following 
at the MS-DOS command prompt:

C:\> WINMSD

The Windows NT Diagnostics dialog box displays the operating system and 
Service Pack version.

❏ The release numbers of the Oracle Server and associated products involved in 
the current problem. For example, Oracle8 Enterprise Edition release 8.1.5.0.0 
and Oracle Enterprise Manager release 2.0.0.0.0.

■ To verify the release number of the Oracle Server, connect to the database 
using a tool such as SQL*Plus. The release number is displayed. For 
example:

Connected to: 
Oracle8i Enterprise Edition Release 8.1.6.0.0 - Production 
With the Partitioning and Java options 
PL/SQL Release 8.1.6.0.0 - Production 

❏ The third-party software version you are using.

■ To verify an application version, from the application’s Help menu, select 
About... 
ix



❏ The exact error codes and messages. Please write these down as they occur. 
They are critical in helping Oracle Support Services to quickly resolve your 
problem. Note whether there were no errors reported.

❏ A description of the issue, including:

■ What happened? For example, the command used and its result. 

 

■ When did it happen? For example, during peak system load, or after a 
certain command, or after an operating system upgrade. In addition, what 
was happening when the problem occurred? 

■ Where did it happen? For example, on a particular system, or within a 
certain procedure or table.
x



■ What is the extent of the problem? For example, production system 
unavailable, or moderate impact but increasing with time, or minimal 
impact and stable. 

■ Did the problem affect one user, several users, or all users? 

■ Has anything changed? For example, if this is an operation that used to 
work and now fails, what is different? Can you undo any recent changes, to 
verify whether they are relevant to the issue? 

■ Can the problem be reproduced? This is a critical question for support 
analysts. For example, did the problem recur on the same system, under the 
same circumstances? Can the problem be reproduced on another system? 
Additionally:

■ Does installing a software component fail on all client machines, or just 
one? 

■ Do all clients fail to connect to the server, or just one?

■ If you are able to restart the server or database, does restarting the database 
or rebooting the server or client machine (if applicable) make a difference?
xi



❏ Keep copies of the Oracle alert log, any trace files, core dumps, and redo log 
files recorded at or near the time of the incident. Oracle Support Services may 
need these to further investigate your problem. 

To help analyze problems: 

■ Archive or delete old alert logs. When the database is started without an 
alert log, a new one is created. In some cases, if you force the problem to 
recur with a new alert log, the timestamps for the recorded events may 
indicate which events are relevant. 

■ Archive or delete old trace files. To check whether the file was modified, 
right-click and select Properties. The Properties dialog box displays the 
modification date.

■ Check the operating system error logs, especially the System log and 
Application log. These files are relevant to the Oracle Server. To view these 
files, from the Start menu, choose Programs > Administrative Tools > Event 
Viewer, and choose System or Application from the Log main menu. 
xii



Resources for Oracle Partners and Developers
This section provides information on partner programs and resources for Oracle database 
administrators and application developers.

Information Source Description

Oracle Corporation Home Page

http://www.oracle.com

This Web site is the starting point for general information on 
Oracle Corporation.

Alliance Online

http://alliance.oracle.com

Oracle provides leading-edge technology, education, and 
technical support that enables you to effectively integrate 
Oracle into your business. By joining the Oracle Partner 
Program, you demonstrate to customers that you are 
committed to delivering innovative Oracle-based solutions 
and services.

The greater your commitment to Oracle, the more we can 
help you grow your business. It’s that simple. The value you 
derive is associated directly with your level of commitment.

Oracle Education

http://education.oracle.com/

Customers come to Oracle Education with a variety of 
needs. You may require a complete curriculum based on 
your job role to enable you to implement new technology. Or 
you may seek an understanding of technology related to 
your key area of responsibility to help you meet technical 
challenges. You may be looking for self-paced training that 
can be used as an ongoing resource for reference and 
hands-on practice. Or, you may be interested in an overview 
of a new product upgrade. Whatever your training need, 
Oracle Education has the solution. 

Oracle Technology Network

http://technet.oracle.com/

The Oracle Technology Network is your definitive source for 
Oracle technical information for developing for the Internet 
platform. You will be part of an online community with 
access to free software, Oracle Technology 
Network-sponsored Internet developer conferences, and 
discussion groups on up-to-date Oracle technology. 
Membership is free.

Oracle Store

http://oraclestore.oracle.com/

This is Oracle’s online shopping center. Come to this site to 
find special deals on Oracle software, documentation, 
publications, computer-based training products, and much 
more.
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Oracle Support Services’ Support Web Center

http://www.oracle.com/support/

Oracle Support Services offers a range of programs so you 
can select the support services you need and access them in 
the way you prefer: by telephone, electronically, or face to 
face. These award-winning programs help you maintain 
your investment in Oracle technology and expertise.

Here are some of the resources available in the Support Web 
Center:

OracleMetaLink

http://www.oracle.com/support/
elec_sup/index.html

OracleMetaLink is Oracle Support Services' premier Web 
support service. It is available to Oraclemetals customers 
(Gold, Silver, Bronze), 24 hours a day, seven days a 
week.

OracleLifecycle

http://www.oracle.com/support/
sup_serv/lifecycle/index.html

OracleLifecycle is designed to deliver customized, 
industry-focused, full life-cycle support solutions that 
enable industry leaders to use Oracle technology to 
make smart business decisions, achieve operational 
excellence, and succeed in their markets.

ExpertONLINE

http://www.oracle.com/support/
sup_serv/online/index.html

Oracle Support Services has launched a new line of 
services called ExpertONLINE. These services provide 
online database administration for companies looking 
to supplement their existing DBA staff or fill a DBA 
role. Services range from ExpertDETECT, a monitoring, 
diagnostic, and recommendation service, to ExpertDBA, 
a full online database administration service.

Virtual Support Analyst (VSA)

http://www.oracle.com/support/
sup_serv/vsa_start.html

VSA is Oracle's Internet e-mail service; it is available to 
U.S. customers with an Oraclemetals support agreement. 
With VSA, you can initiate a request for assistance 
through e-mail, bypassing the queues you may 
encounter when using telephone support. VSA also 
enables you to access Oracle's bug database.

Customer Service

http://www.oracle.com/support/
cus_serv/index.html

This site provides resources to make your interactions 
with Oracle as easy as possible. Among the things you 
can do are:

■ Learn what is a CPU Support Identification (CSI) 
number

■ Update your technical contact information

■ Find out whom to contact for invoice and collection 
issues

■ Request product update shipments

■ Access a glossary of Oracle Support Services terms

Information Source Description
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U.S. Customer Visit Program

http://www.oracle.com/support/
cus_serv/cus_visit.html

This U.S.-based program has been established to help 
our customers understand and obtain maximum benefit 
from the support services they have purchased.

The visit typically offers a customized orientation 
presentation, a comprehensive overview and 
demonstration of Oracle’s electronic services, and 
helpful tips on working more effectively with Oracle 
Support Services.

Support Web Center Library

http://www.oracle.com/support/
library/index.html

This site contains articles, guides, and other 
documentation to help you leverage the wealth of 
knowledge and reference material that Oracle Support 
Services produces.

Information Source Description
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Before You Begin

This guide provides operating system-specific information on using Oracle Parallel 
Server for Windows NT. Other Oracle Parallel Server implementation, installation 
and configuration issues are covered in your Oracle Parallel Server documentation 
set. 

Topics discussed are:

■ Intended Audience

■ Prerequisites

■ Structure
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Intended Audience
This guide is for network administrators and database administrators who install, 
configure, and use Oracle Parallel Server on Windows NT clusters.

Prerequisites
This guide assumes that you are familiar with:

■ Windows NT and have installed and tested it for the cluster and network 
hardware

■ Object-relational database management concepts

Structure
This guide contains the following chapters and appendices.

Chapter 1 New Features in This Release
Describes the new features in this release, and where to find information on 
Oracle Parallel Server for Windows NT.

Chapter 2 Migrating or Upgrading to Release 8.1
Describes the steps to migrate or upgrade to release 8.1.

Chapter 3 Creating Raw Devices
Describes setting up raw devices for Oracle Parallel Server data files, control 
files and redo log files for various configurations.

Chapter 4 Managing Raw Devices
Describes additional utilities in this release to manage raw devices.

Appendix A Directory Structure
Describes the directory structures for Oracle Parallel Server.



Related Documents
For more information on Oracle8i on Windows NT, see the following user guides:

■ Oracle8i Installation Guide for Windows NT

■ Oracle8i Administrator’s Guide for Windows NT

■ Getting to Know Oracle8i

■ Oracle8i Concepts

■ Oracle8i Reference

■ Net8 Administrator’s Guide

Documentation and Code Conventions
The following conventions are used in this guide:

Convention Example Meaning

All uppercase plain ORANT\NETWORK Indicates command names, SQL reserved 
words, and keywords, as in ALTER 
DATABASE. All uppercase plain is also 
used for directory names and file names.

Italic Italic is used to indicate a variable:

filename

Italic is used for emphasis:

The WHERE clause may be used to join 
rows in different tables.

Indicates a value that you must provide. 
For example, if a command asks you to 
type filename, you must type the actual 
name of the file.

Italic is also used for emphasis in the text 
and to indicate the titles of other guides.

Square brackets [ ] X:\[PATHNAME]\ORACLE\
HOME_NAME

Encloses optional items. For example, 
when you create an OFA-compliant 
Oracle home directory, you can place an 
optional pathname before the \ORACLE 
pathname.

Square brackets also indicate a function 
key, for example [Enter].

Choose Start > Choose Start > Programs > Oracle > 
HOME_NAME > Network Administration 
> Net8 Easy Config

How to start a program. For example, to 
start Net8 Easy Config, you must click the 
Start button on the taskbar and then 
choose Programs, Oracle, HOME_NAME 
Oracle Universal Installer. 
xix



C:\> C:\ORACLE\ORA81> Represents the Windows NT command 
prompt of the current hard disk drive. 
Your prompt reflects the subdirectory in 
which you are working. Referred to as the 
MS-DOS command prompt in this guide.

Backslash (\) before a 
directory name

\OPS Indicates that the directory is a 
subdirectory of the root directory.

ORACLE_HOME and 
ORACLE_BASE

Go to the ORACLE_BASE\ORACLE_
HOME\BIN directory

In this Optimal Flexible Architecture 
(OFA)-compliant release, all 
subdirectories are no longer under a top 
level ORACLE_HOME directory. There is 
now a new top level directory called 
ORACLE_BASE that by default is 
C:\ORACLE. 

HOME_NAME OracleHOME_NAMETNSListener80 Represents the Oracle home name.

The home name can be up to sixteen 
alphanumeric characters. The only special 
character allowed in the home name is the 
underscore. 

HOMEID HOME0, HOME1, HOME2 Represents a unique registry subkey for 
each Oracle home directory in which you 
install products. A new HOMEID is 
created and incremented each time you 
install products to a different Oracle home 
directory on one computer. Each 
HOMEID contains its own configuration 
parameter settings for installed Oracle 
products.

Symbols period  .

comma  ,

hyphen  -

semicolon  ;

colon  :

equal sign  =

backslash  \

single quote  ‘

double quote  “

parentheses ()

Symbols other than brackets and vertical 
bars must be entered in commands 
exactly as shown.

Convention Example Meaning
xx



New Features in This Re
1

New Features in This Release

This chapter describes the new features in this release, and where to find 
information on Oracle Parallel Server for Windows NT. 

Specific topics discussed are:

■ New Features In This Release

■ Where to Find Information on Oracle Parallel Server for Windows NT
lease 1-1



New Features In This Release
New Features In This Release
This table describe the new products and features of Oracle Parallel Server release 
8.1.6 specific to Windows NT. 

New Feature Description See...

Oracle Parallel 
Server is now 
automatically 
installed with the 
Typical or Custom 
install type on 
Windows NT. 

During installation, software components are installed on 
the node from which the Oracle Universal Installer is run 
and pushed to the selected nodes in the cluster. 

1. Oracle8i Parallel Server 
Setup and Configuration 
Guide, Chapter 2, 
"Pre-Installation".

2. Oracle8i Installation 
Guide for Windows NT

Create logical 
partitions and 
symbolic links 
utility 

Oracle Object Link Manager 
(GUIORACLEOBJMANAGER.EXE) includes 
ORACLEOBJSERVICE, a Windows NT service that 
monitors symbolic link changes and updates all nodes.

This guide, Chapter 3, 
"Creating Raw Devices".

Manage raw 
devices (from the 
MS-DOS command 
prompt)

■ DELETEDISK.EXE reformats an entire disk

■ LETTERDELETE.EXE removes all drive letters

■ LOGPARTFORMAT.EXE initializes all space in a 
logical partition to zero

■ IMPORTSYMLINKS.EXE reads a .TBL file and marks 
the hard disk partitions with the symbolic link names

■ EXPORTSYMLINKS.EXE exports the current 
symbolic links to a file

This guide, Chapter 3, 
"Creating Raw Devices", and 
Chapter 4, "Managing Raw 
Devices".

Add and remove 
logical drives 
utility

The create logical drives (CRLOGDR) utility adds and 
removes logical drives and their associated symbolic 
drives from the end of the extended partition.

This guide, Chapter 4, 
"Managing Raw Devices".
1-2 Oracle Parallel Server Administrator’s Guide for Windows NT



Where to Find Information on Oracle Parallel Server for Windows NT
Where to Find Information on Oracle Parallel Server for Windows NT
The following table describes where to find the information necessary to set up and 
configure Oracle Parallel Server on Windows NT.

 

*The OSD layer on Windows NT consists of three required software components, CM, Inter-Process Communication (IPC) and IO, 
and an optional component, START, developed by your vendor.

To find information on... See...

Oracle Parallel Server documentation Oracle8i Parallel Server Documentation Online 
Roadmap.

■ Installing and configuring Cluster Manager 
(CM) software

■ Operating System Dependent (OSD) layer, 
required DLLs and their registry entries*

Your hardware vendor documentation.

■ Setting up raw devices on various 
configurations

■ Backing up raw devices

This guide, Chapter 3, "Creating Raw Devices".

Managing raw devices (exporting current symbolic 
links, removing drive letters, etc.) 

This guide, Chapter 4, "Managing Raw Devices".

Other pre-installation tasks Oracle8i Parallel Server Setup and Configuration Guide

Installing Oracle8i Enterprise Edition and the Oracle 
Parallel Server Option on Windows NT

1. Oracle8i Parallel Server Setup and Configuration 
Guide, Chapter 3, "Installing and Creating an 
Oracle Parallel Server Database".

2. Oracle8i Installation Guide for Windows NT 

Migrating or Upgrading to Release 8.1 1. This guide, Chapter 2, "Migrating or Upgrading 
to Release 8.1"

2. Oracle8i Parallel Server Setup and Configuration 
Guide, Chapter 3, "Installing and Creating an 
Oracle Parallel Server Database".

3. Oracle8i Migration

Co-existence of different Oracle Parallel Server 
versions in the same cluster

This guide, Chapter 2, "Migrating or Upgrading to 
Release 8.1".

Configuration tasks common to all operating systems Oracle8i Parallel Server Setup and Configuration Guide

Implementing parallel processing Oracle8i Parallel Server Administration, Deployment, and 
Performance Guide
New Features in This Release 1-3



Migrating or Upgrading to Releas
2

Migrating or Upgrading to Release 8.1

This chapter describes how to migrate from Oracle7 or upgrade an Oracle8 database 
to the present Oracle8i release on Windows NT.

Specific topics discussed are:

■ New Features in Release 8.1

■ Rolling Upgrades

■ Migrating from Oracle7

■ Upgrading the Previous Version 8 Database to the New Oracle8i Release

■ Multiple Oracle Homes

For more information on... See...

Installing the Oracle 
Parallel Server on Windows 
NT

■ Oracle8i Installation Guide for Windows NT 

■ Oracle8i Parallel Server Setup and Configuration Guide

Migrating and upgrading Oracle8i Migration guide:

■ Chapter 4, "Migrating from Oracle7 Using the Migration 
Utility".

■ Chapter 7, "Upgrading from a Previous Version 8 
Release to the New Oracle8i Release".

■ Chapter 8, "After Migrating or Upgrading the 
Database".

 Configuration issues Oracle8i Parallel Server Setup and Configuration Guide
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New Features in Release 8.1
New Features in Release 8.1
The new features in Oracle Parallel Server for Windows NT release 8.1 are described 
in the table below. These features are described in detail in your Oracle8i 
documentation set. 

Rolling Upgrades
Rolling upgrades—where different databases, or different instances of the same 
database in Oracle Parallel Server, are upgraded to a new version of Oracle one at a 
time—are not supported. All software upgrades must be upgraded at the same time 
on all nodes of the cluster, to maintain version consistency. 

New Feature Description

Optimal Flexible Architecture 
(OFA)

Provides a structured method for installing the Oracle8i database and 
applications in a manner which helps promote ease of maintenance, 
improved performance, and reliability. 

Oracle Universal Installer The new installer is based on a Java engine that provides an 
extensible environment able to handle advanced software installation 
requirements. Oracle Universal Installer provides users with a 
consistent interface across all platforms on which Oracle is available. 

Note: Versions of the Installer previous to release 8.1 are referred to as 
"Oracle Installer".

Easy configuration Configuration was a manual process in Oracle8. While this manual 
process is still available for this release, Oracle Database 
Configuration Assistant can be run to create an Oracle Parallel Server 
database. The Oracle Database Configuration Assistant can be run 
automatically after installation or at a later time in stand-alone mode.

OSD Performance and Management 
(P&M) component implemented in 
Oracle Parallel Server Manager 
Option

The P&M component was a vendor-supplied component installed 
with the OSD layer. This component interacted with the Oracle 
Enterprise Manager tools. Because P&M must be implemented in a 
precise manner, this component is now installed with Oracle Parallel 
Server rather than as an OSD module.

Initialization parameter file name 
changes

The initialization parameter file that contains common parameters 
shared from node-to-node was called INIT_COM.ORA in prior 
releases. This file name has been replaced by INITDB_NAME.ORA. 
Each instance still has its own initialization file, typically named 
INIT.ORA.
2-2 Oracle Parallel Server Administrator’s Guide for Windows NT



Migrating from Oracle7
Migrating from Oracle7 
If the Oracle Universal Installer detects an earlier version of an Oracle database on 
your hard drive, you will be prompted to migrate or upgrade the database to 
release 8.1. Do not click the Upgrade or Migrate... check box, as the Oracle Data 
Migration Assistant does not support Oracle Parallel Server. Instead, use the 
Migration utility to migrate after installation. 

Migrating on Windows NT involves disabling the OracleCMService and starting 
and shutting down the Operating System Dependent (OSD) layer at a specific point 
during migration.

Prepare the Oracle7 Source Database for Migration
Complete the following steps before you migrate your Oracle7 database to 
Oracle8i:

1. Start with an Oracle7 database supported by the Migration Utility. If your 
database release number is lower than the release supported by the Migration 
utility on Windows NT, then upgrade or migrate the database to a supported 
release.

2. If the Procedural Option is not installed, then use your Oracle7 installation 
media to install it. To determine if it is installed, start Server Manager or 
SQL*DBA, depending on the version of Oracle7 you are migrating from. 

See: Oracle8i Migration guide, Chapter 4, "Migrating from Oracle7 
Using the Migration Utility" page 4-9, for considerations on using 
the Migration Utility and system requirements.

See: Oracle8i Installation Guide for Windows NT for the Oracle7 
database releases supported by the Migration Utility.

See: Oracle8i Installation Guide for Windows NT for the Oracle7 
database releases supported by Server Manager or SQL*DBA.
Migrating or Upgrading to Release 8.1 2-3



Migrating from Oracle7
The following is an example of the messages you will see when Server Manager 
starts:

Oracle Server Manager Release 2.3.3.0.0 - Production

Copyright (c) Oracle Corporation 1994, 1995. All rights reserved.

Oracle7 Server Release 7.3.4.0.0 - Production
With the distributed, replication, parallel query, Parallel Server
and Spatial Data options
PL/SQL Release 2.3.4.0.0 - Production

If you see "PL/SQL" in the messages, as in the last line in the preceding 
example, then the Procedural Option is installed. Otherwise, it is not installed.

The messages you see may be slightly different, based on the options you have 
installed and their release numbers. 

3. Make sure all data files and tablespaces are either online or offline normal. 

To determine whether any data files require recovery, issue the following SQL 
statement:

SELECT * FROM V$RECOVER_FILE;

You should see a "0 rows selected" message, which indicates that all data files 
are either online or offline normal. If any data files are listed, then you must 
restore the data files before you migrate the database. You can use the 
V$DATAFILE dynamic performance view to find the data file name based on 
the data file number. The Oracle8i Migration utility will not proceed, and will 
display an error, if any data files require media recovery. 

Tablespaces that are not taken offline cleanly must be dropped or brought 
online before migration. Otherwise, these tablespaces will not be available 
under Oracle8i after the migration. Typically, tablespaces that are taken offline 
by using an ALTER TABLESPACE OFFLINE IMMEDIATE or ALTER 
TABLESPACE OFFLINE TEMPORARY statement require media recovery.
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After migration, tablespaces that are offline when you open the Oracle8i 
database remain in Oracle7 database file format. The offline tablespaces can be 
brought online at any time after migration, and the file headers are converted to 
Oracle8i format at that time. In addition, if you want to avoid large restores in 
the event of a failure, then you can make all tablespaces except SYSTEM and 
ROLLBACK offline normal; then, you can restore only the data files for 
SYSTEM and ROLLBACK if you need to run another migration.

4. Make sure no user or role has the name OUTLN, because this schema is created 
automatically when you install Oracle8i. If you have a user or role named 
OUTLN, then you must drop the user or role and recreate it with a different 
name.

To check for a user with the name OUTLN, issue the following SQL statement:

SELECT USERNAME FROM DBA_USERS WHERE USERNAME = ’OUTLN’;

If you do not have a user named OUTLN, then zero rows are selected. 

To check for a role with the name OUTLN, issue the following SQL statement:

SELECT ROLE FROM DBA_ROLES WHERE ROLE = ’OUTLN’;

If you do not have a role named OUTLN, then zero rows are selected.

5. Make sure no user or role has the name MIGRATE, because the Oracle8i 
Migration utility creates this schema and uses it to replace any pre-existing user 
or role with this name, and finally drops it from the system. 

To check for a user with the name MIGRATE, issue the following SQL 
statement:

SELECT USERNAME FROM DBA_USERS WHERE USERNAME = ’MIGRATE’;

If you do not have a user named MIGRATE, then zero rows are selected.

To check for a role with the name MIGRATE, issue the following SQL 
statement:

SELECT ROLE FROM DBA_ROLES WHERE ROLE = ’MIGRATE’;

If you do not have a role named MIGRATE, then zero rows are selected.
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6. Make sure the SYSTEM rollback segment does not have an OPTIMAL setting. 
An OPTIMAL setting may cause errors during migration.

To check the OPTIMAL setting for the SYSTEM rollback segment, issue the 
following SQL statement:

SELECT A.USN, A.NAME, B.OPTSIZE
    FROM V$ROLLNAME A, V$ROLLSTAT B
    WHERE A.USN = B.USN AND NAME = ’SYSTEM’;

Your output should be similar to the following:

USN        NAME                           OPTSIZE   
---------- ------------------------------ ----------
         0 SYSTEM                                   
1 row selected.

If there is a value in the OPTSIZE column, then issue the following SQL 
statement to set optimal to NULL:

ALTER ROLLBACK SEGMENT SYSTEM STORAGE (OPTIMAL NULL);

You can reset OPTIMAL when migration is complete.

7. Increase the maximum number of extents for your SYSTEM rollback segment 
by altering the MAXEXTENTS parameter in the STORAGE clause of the ALTER 
ROLLBACK SEGMENT statement (optional).

The following is an example of the ALTER ROLLBACK SEGMENT statement:

ALTER ROLLBACK SEGMENT system
   STORAGE (MAXEXTENTS 121);

You may need more space in the SYSTEM rollback segment to complete the 
migration successfully. If there is not enough space in your SYSTEM rollback 
segment, then you may encounter errors when you run the Migration utility in 
the Oracle7 environment.
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8. Make sure you have the required release of SQL*Net installed.

If the required release of SQL*Net is not installed, complete the following steps 
to install it:

a. Obtain the year 2000-compliant Oracle Installer for release 7.3 from Oracle 
Corporation.

b. Start the Oracle Installer you obtained in Step a. Respond to the Oracle 
Installer screens until you reach the Software Asset Manager window.

c. At the Software Asset Manager window, click the From button.

d. Navigate to the drive containing the CD-ROM for the current 8.1 release of 
Oracle.

e. Navigate to the appropriate directory on the CD-ROM:

If you are installing SQL*Net release 2.3.2.1.12, navigate to the following 
directory on the CD-ROM: 

\PATCHES\SQLNET\232112\NT_X86\INSTALL

If you are installing SQL*Net release 2.3.3.0.3, navigate to the following 
directory on the CD-ROM: 

\PATCHES\SQLNET\23303\NT_X86\INSTALL

Migrating From Required SQL*Net Release

Oracle release 7.3.2 SQL*Net release 2.3.2.1.12 or higher

Note: If your release of SQL*Net is below release 
2.3.2.1.4, you must first install release 2.3.2.1.4 before 
you can upgrade to release 2.3.2.1.12. Contact Oracle  
Support Services to obtain the patch that includes 
release 2.3.2.1.4.

Oracle release 7.3.3 SQL*Net release 2.3.3.0.3 or higher
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f. Open the NT.PRD file.

g. Complete the installation.

h. Exit the Oracle Installer.

Prepare the Cluster for Installation
To prepare the cluster for the Oracle8i Enterprise Edition software, perform the 
following steps on each node in the cluster:

1. Shut down the Oracle7 database cleanly using the SHUTDOWN NORMAL or 
SHUTDOWN IMMEDIATE command; do not use SHUTDOWN ABORT. The 
Oracle7 source database must be shut down cleanly; therefore, no redo 
information or uncommitted transactions can remain. 

C:> SVRMGR23
SVRMGR> CONNECT INTERNAL
SVRMGR> SHUTDOWN IMMEDIATE

2. Ensure all Oracle7 services are shutdown, including the OracleCMService 
service:

a. Double-click the Services icon in the Control Panel window.

The Services dialog box appears.

b. Select an OracleServiceSID.

c. Click Stop to stop a service.

3. Change all the version 7 OSDs including the OracleCMService service to 
Manual startup:

a. Double-click the corresponding version 7 OSD and the OracleCMService 
service. The Services dialog box appears.

b. Click Manual in the Startup Type group box.

c. Click OK to dismiss the Services dialog box.

d. Click Close in the Services dialog box.

Note: If you cannot install the required SQL*Net release, contact 
Oracle Support Services.
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4. Shut down the version 7 OSD layer, as described in your vendor 
documentation. In most cases, you can use the same procedure as stopping an 
Oracle service, described in Step 2. 

5. Rename the OSD key under HKEY_LOCAL_
MACHINE\SOFTWARE\ORACLE to OSD73 using the registry editor, 
REGEDIT. OSD73 acts as a temporary storage for the version 7 OSD layer, 
which will be used later in the migration process. 

To start the registry:

a. Choose Start > Run, enter REGEDIT in the Open field, and click OK.

The Registry Editor window appears.

b. Right-click to rename the OSD key.

6. Install the version 8.1 OSD layer, being sure not to overwrite the version 7 OSD 
files. See your vendor documentation for further information. 

7. Start the version 8.1 OSD layer, as described in your vendor documentation. 
Perform diagnostics on the clusterware as described in your vendor 
documentation. 

8. Backup raw partitions using OCOPY. Enter the following syntax: 

C:\> OCOPY \\.\PHYSICALDRIVEN NEW_FILE
where:

■ PHYSICALDRIVE is the physical drive that holds a single raw database file

■ N is the number(s) representing each of the physical drives in the system

■  NEW_FILE is the name and location of the backup copy

For example, to backup the logical partition for a system tablespace to a file, 
enter:

C:\> OCOPY \\.\OPS_SYSTEM1 OPS_SYSTEM1

Use your existing partitions and symbolic link names. Oracle Corporation 
recommends you backup logical partitions to files with the same name. For 
example, backup \\.\OPS_SYSTEM1 to a file named OPS_SYSTEM1.

See:  Oracle8i Administrator’s Guide for Windows NT, Chapter 11, 
Backing Up and Recovering Database Files, on using OCOPY.
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Install the Release 8.1 Oracle8i Enterprise Edition
During installation, software components are installed on the node from which 
Oracle Universal Installer is run and pushed to the selected nodes in the cluster. The 
Oracle Universal Installer installs Oracle Parallel Server only if a cluster is detected.

Perform the following step before running Oracle Universal Installer:

From the node where you intend to run the installer, verify you have administrative 
privileges to the other nodes. Enter the following command for each node that is a 
part of the cluster:

NET USE \\HOST_NAME\C$ 

where host_name is the host name defined in the DefinedNodes registry value for 
Cluster Manager.

A successful connection results in the following message:

The command completed successfully.

Oracle Corporation recommends using the same user name and password on each 
node in a cluster or use a domain user name. If you use a domain user name, log on 
under a domain with username and password which has administrative privileges 
on each node.

To install Oracle8i Enterprise Edition on one node in the cluster:

1. At the Welcome screen of the Oracle Universal Installer, click Next. The File 
Locations screen appears.

If you need help at any screen or want to consult more documentation about the 
Oracle Universal Installer, then click the Help button to open the online help.

See : Oracle8i Installation Guide for Windows NT to prepare for 
installation and start the Oracle Universal Installer.
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2. At the File Locations screen, complete the following steps:

a. Do not change the text in the Source field. This is the location of files used 
for installation.

b. If there is a Destination Name field, enter the name of a new Oracle home in 
this field. 

c. Enter the complete path of the Oracle home directory where you want to 
install the new release in the Destination Path field. Click the Browse button 
to navigate to the directory. Click Next.

The Available Products screen appears.

3. Select Oracle8i Enterprise Edition from the Available Products page. Click Next.

4. Select either Typical or Custom from the Installation Types page. Minimal is not 
supported for Oracle Parallel Server.

Note: You must install the new 8.1 release in an Oracle home 
separate from the Oracle7 release. 

Typical Installation Type Custom Installation Type

Net8 Configuration Assistant and Oracle Database 
Configuration Assistant run after software installation 
with no user input. Net8 Configuration Assistant 
creates the network configuration. Oracle Database 
Configuration Assistant creates a starter database and 
adds necessary information to the network 
configuration. 

Oracle Universal Installer prompts you with a choice 
to create a database by using one of the following 
methods: 

■ Oracle Database Configuration Assistant during 
installation

■ Oracle Database Configuration Assistant or 
manual methods sometime after installation
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After you make your selection, click Next.

If you chose Custom, the Available Product Components screen appears. Complete 
the following steps:

a. Ensure Oracle Parallel Server under the Oracle Database Options folder is 
selected in the Available Product Components screen. Click Next. 

Make sure you install Oracle Utilities to install the Migration utility.

Make sure you install all of the options you installed with the Oracle7 
database, assuming you do not want to discontinue use of a particular 
option. For example, if you installed Oracle replication in Oracle7, then you 
should install it in Oracle8i. 

b. Select the nodes to which you want the software installed from the Cluster 
Node selection page. Click Next.

The node on which you are running the installation is selected whether or 
not you select it.

If the list of nodes does not include nodes you expect, the vendor-supplied 
clusterware is either not running, or not properly configured.

 

c. In the Database Identification page, enter an appropriate global database 
name, a name comprised of the database name and database domain, such 
as OP.US.ACME.COM, and accept or change the common prefix that is to 
be used for the SID for each instance.

Each instance has a SID that is comprised of the common prefix entered 
here and a thread ID that is automatically generated. For example, if OP is 
entered, the first instance in the cluster is given a SID of OP1, and the 
second instance is given a SID of OP2.

d. Respond to the remaining screens that enable you to specify your custom 
installation settings, until you reach the Upgrading or Migrating an Existing 
Database page.
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5. At the Upgrading or Migrating an Existing Database page, leave the Upgrade or 
Migrate an Existing Database check box unselected. Click Next.

6. At the Create Database page, select the No option, indicating that you do not 
want to create a database, because you are migrating an existing database. Click 
Next.

Complete any remaining screens until you reach the Summary page. Click the 
Help button if you need help for a certain screen.

7. At the Summary screen, make sure all of the settings and choices are correct for 
your installation. Then, click Install. The Oracle Universal Installer performs the 
installation, which may take some time.

During installation no message appears to indicate components are installed to 
the other nodes.

8. When installation is completed successfully, click the Exit button to close the 
Oracle Universal Installer.

Perform Post-Installation Steps
To prepare the cluster for the Oracle7 migration process, perform the following 
steps:

1. Shut down and restart your computer.

2. Change the OracleCMService and the OracleServiceSID services to Manual 
startup:

a. Double-click the Oracle8i service. The Services dialog box appears.

b. Click Manual in the Startup Type group box.

c. Click OK to dismiss the Services dialog box.

d. Click Close in the Services dialog box.

Attention: If you select the Upgrade or Migrate an Existing 
Database check box, then the Oracle Data Migration Assistant is 
started automatically after installation. The Oracle Data 
Migration Assistant does not support Oracle Parallel Server 
migrations. Do not start the Oracle Data Migration Assistant.
Migrating or Upgrading to Release 8.1 2-13



Migrating from Oracle7
3. Shut down the release 8.1 OSD layer on each node in the cluster, as described in 
your vendor documentation.

4. On the node from which you intend to run the Migration utility, rename the 
OSD key under HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE to OSD81 
using the Registry Editor, REGEDIT. OSD81 acts as a temporary storage for the 
release 8.1 OSD layer while the Oracle7 database is being migrated or 
upgraded.

To start the registry:

a. Choose Start > Run, enter REGEDIT in the Open field, and click OK.

The Registry Editor window appears.

b. Right-click to rename the OSD key.

5. On the node from which you intend to run the Migration utility, start the 
version 7 OSD layer, as described in your vendor documentation.

6. On the node from which you intend to run the Migration utility, start the 
OracleCMService and the OracleServiceSID services:

a. Double-click the Services icon in the Control Panel window. The Services 
dialog box appears.

b. Select an Oracle service.

c. Click Start.

d. Click Close to dismiss Services dialog box.

7. On the node from which you intend to run the Migration utility, set the Oracle 
home path to the Oracle7 Oracle home path with a tool such as the Oracle 
Home Selector:

a. Choose Start > Programs > Oracle Installation Products > Oracle Home 
Selector. 

b. Select the Oracle7 home from the drop-down list. 
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Migrate the Oracle7 Source Database
Complete the steps in the Oracle7 environment to migrate an Oracle7 source 
database to Oracle8i using the Migration utility.

1. Start up your Oracle7 database:

C:> SVRMGR23
SVRMGR> CONNECT INTERNAL
SVRMGR> STARTUP

2. Make sure the NLS_LANG environment variable is set to the character set you 
are using for your database. 

To check your character set, issue the following SQL statement:

SELECT * FROM V$NLS_PARAMETERS 
   WHERE PARAMETER = ’NLS_LANGUAGE’   
      OR PARAMETER = ’NLS_TERRITORY’
      OR PARAMETER = ’NLS_CHARACTERSET’;

You use all three values returned by this query to set NLS_LANG. For example, 
suppose your output for the query above is the following:

PARAMETER                   VALUE                                                           
---------------------  --------------------------- 
NLS_LANGUAGE               AMERICAN                                                        
NLS_TERRITORY              AMERICA                                                         
NLS_CHARACTERSET          US7ASCII                                                        

In this case, set NLS_LANG to the following at an MS-DOS command prompt:

AMERICAN_AMERICA.US7ASCII

See: Oracle8i National Language Support Guide for information 
about setting NLS_LANG.
Migrating or Upgrading to Release 8.1 2-15



Migrating from Oracle7
3. Make sure you have DBA privileges, which are required to run the Oracle8i 
Migration utility.

To check if you have DBA privileges, query the DBA_ROLE_PRIVS static data 
dictionary view. For example, if you are connected as user SYSTEM, then enter 
the following SQL statement:

SELECT * FROM DBA_ROLE_PRIVS WHERE GRANTEE = ’SYSTEM’;

You have DBA privileges if ’DBA’ is listed in the GRANTED_ROLE column for 
the user. If you do not have DBA privileges, then connect as a user who does.

4. Make sure no other DBA with RESTRICTED SESSION privilege connects to the 
database while the Migration utility is running. Also, "Normal" users should 
not connect to the database during migration.

5. Determine the files that you will back up in Step 8 by issuing the following SQL 
statements:

SPOOL V7FILES.LOG;
SELECT MEMBER FROM V$LOGFILE;
SELECT NAME FROM V$DATAFILE;
SELECT VALUE FROM V$PARAMETER WHERE NAME = 'CONTROL_FILES';
SPOOL OFF;

The V7FILES.LOG spool file lists all of the files that you must back up in Step 8.

6. Shutdown the Oracle7 database cleanly using the SHUTDOWN NORMAL or 
SHUTDOWN IMMEDIATE statement; do not use SHUTDOWN ABORT. The 
Oracle7 source database must be shut down cleanly; therefore, no redo 
information or uncommitted transactions can remain. 

C:> SVRMGR23
SVRMGR> CONNECT INTERNAL
SVRMGR> SHUTDOWN IMMEDIATE

Note: If you do not shut down the Oracle7 database before 
migration starts, then the Migration utility will stop and display an 
error message.
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7. Shutdown all Oracle Parallel Server services.

a. Double-click the Services icon in the Control Panel window. The Services 
dialog box appears.

b. Select an Oracle Parallel Server OracleServiceSID.

c. Click Stop.

d. Click Close to dismiss Services dialog box.

8. Make a complete backup of your Oracle7 database. Make sure you back up the 
files listed in the V7FILES.LOG spool file that you generated in Step 5.

Caution: If you encounter any problems with the migration, you 
will need to restore the database from this backup. Make sure you 
back up your database now as a precaution.

See: The Oracle7 Server Administrator’s Guide for information 
about backing up your Oracle7 database.
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Run the Migration Utility
Complete the following steps to run the Migration Utility:

1. In the new Oracle8i Oracle home, run the Migration utility by entering the 
Migration utility command at the MS-DOS command line with the PFILE 
option included:

C:\> MIG PFILE=ORACLE7_HOME\DATABASE\INIT_PARAM_FILE

Replace the ORACLE7_HOME variable with the complete path to the Oracle7 
Oracle home directory. Also, replace the INIT_PARAM_FILE variable with the 
full name of the initialization parameter file for the Oracle7 database.

For example, if the ORACLE7_HOME is C:\ORANT and the INIT_PARAM_
FILE is INITORCL.ORA, then enter the following:

C:\> MIG PFILE=C:\ORANT\DATABASE\INITORCL.ORA

You can enter MIG with the PFILE option only to run the Migration utility with 
a default set of options, or you can enter MIG followed by more selected 
options.

2. If the Oracle7 Password dialog box appears when you run the Migration utility, 
then enter the password for the INTERNAL user on the Oracle7 database. This 
prompt appears because the DBA_AUTHORIZATION registry parameter is set 
improperly or is not set at all.

3. After the Migration utility has run successfully, stop the Oracle7 service 
OracleServiceSID. For example, if your SID is OP1:

a. Double-click the Services icon in the Control Panel window. The Services 
dialog box appears.

b. Select OracleServiceOP1.

c. Click Stop.

d. Click Close to dismiss Services dialog box.

See: Oracle8i Migration guide, "Review Migration Utility 
Command-Line Options" on page 4-17 for information about 
MS-DOS command line options. Oracle Corporation recommends 
using the spool option, because it makes it easier to check your 
migration results when the migration is complete.
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4. Delete the Oracle7 service at the MS-DOS command prompt using ORADIM7x. 
The following table lists the MS-DOS command to run for each Oracle7 release:

For example, if your Oracle7 release is release 7.3.4 and your SID is ORCL, then 
enter the following at the MS-DOS command prompt:

C:\> ORADIM73 -DELETE -SID ORCL

5. Restart your computer.

6. Create the Oracle8i database service at the MS-DOS command line:

C:\> ORADIM -NEW -SID SID -INTPWD PASSWORD -MAXUSERS USERS -STARTMODE AUTO 
     -PFILE ORACLE_HOME\DATABASE\INITSID.ORA 

This syntax includes the following variables: 

For example, if your SID is ORCL, your PASSWORD is TWxy579, the maximum 
number of USERS is 10, and the ORACLE_HOME directory is C:\ORA81, then 
enter the following command:

C:\> ORADIM -NEW -SID ORCL -INTPWD TWxy579 -MAXUSERS 10 -STARTMODE AUTO 
     -PFILE C:\ORA81\DATABASE\INITORCL.ORA 

Oracle7 Release... Enter at the MS-DOS Command Prompt...

7.1 C:\> ORADIM71 -DELETE -SID SID

7.2 C:\> ORADIM72 -DELETE -SID SID

7.3 C:\> ORADIM73 -DELETE -SID SID

SID is the same SID name as the SID of the version 7 database you 
migrated.

PASSWORD is the password for the new release 8.1 database instance. This is the 
password for INTERNAL user. The -INTPWD option is not 
required. If you do not specify it, then operating system 
authentication is used, and no password is required. 

USERS is the maximum number of users who can be granted SYSDBA and 
SYSOPER privileges.

ORACLE_HOME is the release 8.1 Oracle home directory. Ensure that you specify the 
full pathname with the -PFILE option, including drive letter of the 
Oracle home directory.
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Check the Migration Results
Check the results after running the Migration utility. The Migration utility generates 
informational messages and echoes its progress as it runs the MIGRATE.BSQ script.

The Migration utility creates a convert file that contains the information of the 
Oracle7 control file. Later in the migration process, the convert file is used by 
ALTER DATABASE CONVERT to create a new control file in Oracle8i. 

The default location is ORACLE_HOME\RDBMS in the Oracle8i environment, and 
the default file name in this directory is CONVERT.ORA. 

Preserve the Oracle7 Source Database 
After you successfully run the Migration utility, perform a cold backup of the 
Oracle7 database. This backup serves the following purposes: 

■ If you wish to return to the Oracle7 database after executing the ALTER 
DATABASE CONVERT statement on Oracle8i, then you can restore the backup, 
start the Oracle7 database, and complete procedures in abandoning migration.

See: If the Migration utility exits with an ORA- error, check the 
Oracle8i Migration guide, Appendix A, "Troubleshooting Migration 
Problems" for information about the error and the actions to 
perform to resolve the problem. 

Caution: Do not open the Oracle7 database, which was shut down 
by the Oracle8i Migration utility. To ensure data file version 
integrity, the SCNs in the dictionary, the convert file, and file header 
must all be consistent when the database is converted to Oracle8i. If 
the Oracle7 database is opened after running the Migration utility, 
then the SCN check will fail when the database is converted to 
Oracle8i, and an ORA-1211 error will be displayed, stating "Oracle7 
data file is not from migration to Oracle8". Therefore, if the Oracle7 
database is opened, then you must rerun the Migration utility, 
starting at Step 6 on page 2-16.

See: Oracle8i Migration guide, "Abandoning the Migration" on 
page 4-35.
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■ It can be used as the first Oracle8i backup for an Oracle8i recovery. 

■ If an error occurs at Oracle8i database convert time (ALTER DATABASE 
CONVERT or ALTER DATABASE OPEN RESETLOGS), then you can restore 
this backup, fix the problems, and continue the conversion process. However, if 
you restore a backup that was performed before you ran the Migration utility, 
then you must rerun the Migration utility. 

In addition, perform a backup of the entire Oracle7 software distribution, including 
the Oracle7 home directory. Make sure the backup includes the following: 

■ all of the subdirectories

■ control files

■ data files and online redo log files (in case any data files in the Oracle7 database 
are lost or unreadable), although these files should not contain any outstanding 
redo information.

■ parameter files

■ convert file

■ scripts that create objects in the Oracle7 database

■ scripts that could restore the original database, if necessary

Perform Post-Oracle7 Migration Steps
To complete the Oracle Parallel Server migration, perform the following steps:

1. On the node from which you ran the Migration utility:

a. Stop the OracleCMService and the OracleServiceSID services:

See: The Oracle7 Server Administrator’s Guide for information 
about performing backup and restore operations on your Oracle7 
database.

1. Double-click the Services icon in the Control Panel window. The 
Services dialog box appears.

2. Select an Oracle service.

3. Click Stop.

4. Click Close to dismiss Services dialog box.
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b. Stop the version 7 OSD layer, as described in your vendor documentation.

c. Rename the OSD key under HKEY_LOCAL_
MACHINE\SOFTWARE\ORACLE to OSD73 using the Save Subtree As 
option under the File menu. 

This disables the version 7 OSD layer.

d. Rename the OSD81 key under HKEY_LOCAL_
MACHINE\SOFTWARE\ORACLE to OSD using the Save Subtree As 
option under the File menu. 

This enables the release 8.1 OSD layer.

e. Set the Oracle home path to the Oracle8i Oracle home path with a tool such 
as the Oracle Home Selector:

1. Choose Start > Programs > Oracle Installation Products > Oracle Home 
Selector. 

2. Select the Oracle8i home from the drop-down list. 

2. Perform the following on each node in the cluster:

a. Delete the Oracle7 OracleServiceSID service using the appropriate version 
of ORADIM. From the Oracle7 Oracle home MS-DOS command prompt, 
enter:

C:> CD ORACLE7_HOME/BIN
C:> ORADIM73 -DELETE - SID SID

b. Create an Oracle8i OracleServiceSID service for each instance

C:> ORADIM -NEW -SID SID -INTPWD INTERNAL_PWD -STARTMODE AUTO -PFILE
DRIVE:\PATH\INITSID.ORA

Perform Migration Steps in the Oracle8i Environment
Complete the following migration steps in the Oracle8i environment:

1. On all nodes, either remove or rename the database’s control files, or use the 
CONTROL_FILES initialization parameter to specify new control file names. 
The CONTROL_FILES initialization parameter typically is set in the 
initialization parameter file, but it may be set in the INITDB_NAME.ORA file 
instead.
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You will issue the ALTER DATABASE CONVERT statement in Step 10 on 
page 2-27. This statement automatically creates new control files. If you do not 
use the CONTROL_FILES parameter, then this statement uses the control file 
names of your pre-migration database (derived from the CONVERT file) and 
returns an error if the control files already exist. Therefore, in this case, you 
must remove or rename the control files.

However, if you use the CONTROL_FILES initialization parameter to specify 
new control file names, then the ALTER DATABASE CONVERT statement 
creates the new control files with the names you specify, and you do not need to 
remove the old control files. For a complete list of your existing control files, 
check the V7FILES.LOG spool file you created.

Control files are considerably larger in Oracle8i than in Oracle7. For example, 
Oracle7 control files in the hundreds of kilobytes may expand into tens of 
megabytes in Oracle8i. The larger size in Oracle8i results from the storage of 
more information in the control file, such as backup and tablespace records. 
This size increase could be important if a control file is on a raw device or if its 
available disk space is restricted.

2. On all nodes, copy files that are important for migration to a location outside of 
the Oracle7 Oracle home:

a. The convert file, CONVERT.ORA, should reside in ORACLE_
HOME\RDBMS in the Oracle8i environment. It is placed in this directory 
automatically by the Migration utility, and you do not need to move it.

b. If you have a password file that resides within the Oracle7 Oracle home, 
then move or copy the password file to the Oracle8i Oracle home directory. 

The default password file is ORACLE_HOME\DATABASE\PWDSID.ORA. 
where SID is your Oracle instance ID. 

Note: The CONTROL_FILES initialization parameter specifies one 
or more names of control files, separated by commas. Oracle 
Corporation recommends using multiple files on different devices 
or mirroring the file at the operating system level. See Oracle8i 
Administrator’s Guide for more information.
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c. If your initialization parameter file resides within the Oracle7 Oracle home, 
then move or copy it to a location outside of the Oracle7 Oracle home. By 
default Oracle looks for the initialization parameter file in ORACLE_
HOME\DATABASE. The initialization parameter file can reside anywhere 
you wish, but it should not reside in the Oracle7 Oracle home after you 
migrate to Oracle8i.

d. If the initialization parameter file contains an IFILE (include file) entry that 
resides within the Oracle7 Oracle home, then move or copy the file 
specified in the IFILE entry to a location outside of the Oracle7 Oracle 
home.

e. If your INITDB_NAME.ORA file resides within the Oracle7 Oracle home, 
then move or copy the INITDB_NAME.ORA file to a location outside of the 
Oracle7 Oracle home. 

3. On all nodes, adjust the initialization parameter file in the Oracle8i environment 
for use with Oracle8i. Specifically, complete the following steps:

a. Set the COMPATIBLE initialization parameter in your initialization 
parameter file to a valid version 8 setting, such as 8.0.6 or 8.1.6. Make sure 
the COMPATIBLE parameter is not set to any Oracle7 release, because if it 
is, then you will not be able to start the Oracle8i database. 

b. Remove obsolete parameters and adjust changed parameters. Certain 
Oracle7 initialization parameters are obsolete in version 8. Remove all 
obsolete initialization parameters from any initialization parameter file that 
will start an Oracle8i instance; obsolete parameters may cause errors in 
Oracle8i. Also, alter any parameter whose syntax has changed in version 8. 

c. If you are updating snapshots automatically by using the JOB_QUEUE_
PROCESSES initialization parameter, set JOB_QUEUE_PROCESSES to 0 
(zero) during migration. After migrating your database, you can reset it to 
use this parameter.

See : Oracle8i Migration guide,"Setting the COMPATIBLE 
Initialization Parameter" on page 9-6 for information.

See: Oracle8i Migration guide, Appendix B, "Changes to 
Initialization Parameters" for lists of new, renamed, and obsolete 
parameters, andOracle8i Parallel Server Concepts and Administration 
for more information about obsolete Oracle Parallel Server 
initialization parameters.
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d. Set the PARALLEL_SERVER parameter to FALSE in the INIT.ORA file. This 
only needs to be set on the node from which you ran the Migration utility. 
Setting this parameter to FALSE ensures the database will be started in 
EXCLUSIVE mode, which is required to run the Oracle8i migration. You 
can change it back to TRUE after migration is complete.

e. Make sure your DB_DOMAIN initialization parameter is set properly.

f. Change the BACKGROUND_DUMP_DEST and USER_DUMP_DEST 
initialization parameters that point to RDBMS71, RDBMS72, or RDBMS73 
to point to the following directories instead (optional):

In the settings, substitute the complete ORACLE_BASE path for ORACLE_
BASE and substitute the database name for DB_NAME.

g. Make sure all path names in the initialization parameter file are fully 
specified. You should not have relative path names in the initialization 
parameter file. 

h. If the initialization parameter file contains an IFILE entry, then change the 
IFILE entry in the initialization parameter file to point to the new location 
you copied it to in Step 2. Then, edit the file specified in the IFILE entry in 
the same way that you edited the initialization parameter file in sub-steps a 
to g.

i. Modify the INITDB_NAME.ORA file in the same way that you modified 
the initialization parameter file on page 2-24, steps a to g.

Make sure you save all of the files you modified after making these 
adjustments.

See: Oracle8i Migration guide, "The DB_DOMAIN Parameter" on 
page B-9 for more information about setting this initialization 
parameter.

Initialization Parameter Change Setting To

BACKGROUND_DUMP_DEST ORACLE_BASE\ORADATA\DB_NAME

USER_DUMP_DEST ORACLE_BASE\ORADATA\DB_NAME\ARCHIVE
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4. If the Oracle8i DB_NAME is different from the Oracle7 DB_NAME, then 
complete the following step. Otherwise, skip to Step 5.

Set the DB_NAME initialization parameter in the initialization parameter file to 
the Oracle8i database name.

5. Make sure all online data files are accessible and in the correct directories. If you 
are using a raw disk, then log files also must be accessible.

6. Change to the ORACLE_HOME\RDBMS\ADMIN directory. You should be in 
the Oracle8i Oracle home. 

7. Start Server Manager. Enter SVRMGRL at the MS-DOS command prompt to 
start Server Manager in Oracle8i.

8. Connect to the database instance as user INTERNAL. 

SVRMGR> CONNECT INTERNAL

9. Start an Oracle8i database instance without mounting the new Oracle8i 
database:

SVRMGR> STARTUP NOMOUNT 

You may need to use the PFILE option to specify the location of your 
initialization parameter file.

You may see error messages listing obsolete initialization parameters. If so, then 
make a note of the obsolete initialization parameters and continue with the 
migration normally. Then, remove the obsolete initialization parameters the 
next time you shut down the database (Step 18).

Caution: Starting the database instance in any other mode might 
corrupt the database.
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10. Create a new Oracle8i database control file and convert the file headers of all 
online tablespaces to Oracle8i format by issuing the following statement:

SVRMGR> ALTER DATABASE CONVERT;

Successful execution of this statement is the "point of no return" to Oracle7 for 
this database. However, if necessary, you can restore the Oracle7 database from 
backups.

If errors occur during this step, then correct the conditions that caused the 
errors and rerun the Migration utility. Restart at Step 1, "Startup your Oracle7 
database:" on page 2-15. Otherwise restore the backup you performed after you 
ran the Migration utility.

11. Open the Oracle8i database with the following statement: 

SVRMGR> ALTER DATABASE OPEN RESETLOGS; 

When the Oracle8i database is opened, all rollback segments that are online are 
converted to the new Oracle8i format. 

If you encounter errors when you issue this statement, then start the migration 
process over from the beginning, ensuring the database is not opened in the 
Oracle7 environment after the Migration utility completes. Make sure you 
completed all of the pre-migration steps.

12. Set the system to spool results to a log file for later verification of success:

SVRMGR> SPOOL CATOUTM.LOG

If you want to see the output on your screen of the scripts you will run, then 
you also can issue a SET ECHO ON statement:

SVRMGR> SET ECHO ON

See: Oracle8i Migration guide, "Problems at the ALTER 
DATABASE CONVERT Statement" on page A-16 for information 
about common errors encountered at this step and the actions 
required to resolve them.
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13. Run the Oracle8i database conversion script U0703040.SQL: 

SVRMGR> @U0703040.SQL

The U0703040.SQL script is the database conversion script for all 7.1, 7.2, and 
7.3 releases supported by the Migration utility. The U0703040.SQL script creates 
and alters certain system tables and drops the MIGRATE user. It also runs the 
CATALOG.SQL and CATPROC.SQL scripts, which create the system catalog 
views and all the necessary packages for using PL/SQL. 

If you encounter any problems when you run this script, or any of the scripts in 
the remaining steps, then correct the cause(s) of the problems and rerun the 
script. You can rerun any of the scripts described in this chapter as many times 
as necessary.

14. If the Oracle system has Oracle replication installed, then complete the 
following steps:

a. Run CATREP.SQL:

SVRMGR> @CATREP.SQL

b. Run R0703040.SQL:

SVRMGR> @R0703040.SQL

This R0703040.SQL script performs a post-CATREP.SQL Oracle replication 
related upgrade.

15. Run CATPARR.SQL:

SVRMGR> @CATPARR.SQL

16. Run UTLRP.SQL (optional):

SVRMGR> @UTLRP.SQL

The UTLRP.SQL script recompiles all existing PL/SQL modules that were 
previously in an INVALID state, such as packages, procedures, types, and so 
on. These actions are optional; however, they ensure that the cost of 
recompilation is incurred during installation rather than in the future.

Oracle Corporation highly recommends performing this optional step.

See: Oracle8i Migration guide, "Running Scripts" on page 1-11 for 
information about the types of errors to look for when you run a 
script.
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17. Turn off the spooling of script results to the log file:

SVRMGR> SPOOL OFF 

Then, check the spool file and verify that the packages and procedures 
compiled successfully. You named the spool file in Step 12; the suggested name 
was CATOUTM.LOG. 

You should look for errors that alert you to insufficient space, and for errors that 
alert you that a script failed to run. If you see these types of errors, then your 
migration may not be completely successful. However, you typically can ignore 
errors about the failure to alter or drop an object that does not exist.

If you specified SET ECHO ON, then you may want to SET ECHO OFF now:

SVRMGR> SET ECHO OFF

18. Run SHUTDOWN on the Oracle8i database: 

C:> SVRMGRL
SVRMGR> CONNECT INTERNAL
SVRMGR> SHUTDOWN IMMEDIATE

Executing this clean shutdown flushes all caches, clears buffers, and performs 
other DBMS housekeeping activities. These measures are an important final 
step to ensure the integrity and consistency of the newly migrated Oracle8i 
database.

The COMPATIBLE initialization parameter controls the compatibility level of 
your database. Set the COMPATIBLE initialization parameter in your 
initialization parameter file based on the compatibility level you want for your 
migrated database.

Also, if you encountered a message listing obsolete initialization parameters 
when you started the database in Step 9, then remove the obsolete initialization 
parameters from the initialization parameter file now.

19. Set the PARALLEL_SERVER parameter back to TRUE in the INIT.ORA file. 

Caution: Use SHUTDOWN NORMAL or SHUTDOWN 
IMMEDIATE. Do not use SHUTDOWN ABORT.

See: Oracle8i Migration guide, "Setting the COMPATIBLE 
Initialization Parameter" on page 9-6 for information.
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Perform Post-Migration Tasks
Complete the post-migration procedures listed in the table below. These are 
described in Oracle8i Migration guide, Chapter 8, "After Migrating or Upgrading the 
Database".

Post-Migration Tasks

■ Perform a complete backup of the production database.    

■ Change the password for the OUTLN user.

■ Copy LONGs to LOBs.

■ Check for bad date constraints.    

■ Adjust the initialization parameters SHARED_POOL_SIZE and LARGE_POOL_
SIZE in your initialization parameter file to avoid problems with parallel execution.

■ If you installed the Java option, install ODCI.JAR AND CARTRIDGESERVICES.JAR 
files.

■ Modify your LISTENER.ORA file.

■ Migrate or upgrade your standby database to Oracle8i release 8.1.

■ Add new features as appropriate. It is not necessary to make any immediate 
changes to begin using your Oracle8i database. You may prefer to introduce these 
enhancements into your database and corresponding applications gradually. 

■ Develop new administrative procedures as needed.

■ Adjust your initialization parameter file for the new release.

■ Rebuild unusable bitmap indexes.

■ Migrate partition views to partition tables.

■ Migrate or upgrade to the new release of Net8 (optional).

■ Test the database and compare results.

■ Tune the migrated database.
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Upgrading the Previous Version 8 Database to the New Oracle8i 
Release

This section guides you through the process of upgrading your database to the new 
Oracle8i release.  

Prepare to Upgrade
Perform the following steps on one node only:

1. Review upgrade issues relating to SQL*Net and Net8.

2. Make sure your DB_DOMAIN initialization parameter is set properly.

3. Start Server Manager and connect to the database instance as INTERNAL user.

C:> SVRMGRL
SVRMGR> CONNECT INTERNAL

4. If you are upgrading from an 8.0 release, then make sure no user or role has the 
name OUTLN, because this schema is created automatically when you install 
Oracle8i. If you have a user or role named OUTLN, then you must drop the 
user or role and recreate it with a different name.

See: Oracle8i Migration guide for important information on 
upgrade paths.

See: Oracle8i Migration guide, Appendix F, "SQL*Net and Net8 
Considerations for Migrations and Upgrades" for information.

See: Oracle8i Migration guide, "The DB_DOMAIN Parameter" on 
page B-9 for more information about setting this initialization 
parameter.

Note: If you are upgrading from an 8.1 release, then you do not 
need to perform this check because the OUTLN user should have 
been created when you installed the previous 8.1 release. Therefore, 
if you are upgrading from an 8.1 release, then go to Step 5 now. Do 
not drop the OUTLN user if you are upgrading from a previous 8.1 
release.
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To check for a user with the name OUTLN, enter the following SQL statement:

SELECT USERNAME FROM DBA_USERS WHERE USERNAME = ’OUTLN’;

If you do not have a user named OUTLN, then zero rows are selected. 

To check for a role with the name OUTLN, enter the following SQL statement:

SELECT ROLE FROM DBA_ROLES WHERE ROLE = ’OUTLN’;

If you do not have a role named OUTLN, then zero rows are selected.

5. Add space to your SYSTEM tablespace and to the tablespaces where you store 
rollback segments, if necessary.

Upgrading to a new release requires more space in your SYSTEM tablespace 
and in the tablespaces where you store rollback segments. If you have enough 
space on your system, then consider adding more space to these tablespaces. In 
general, you need at least 20 MB of free space in your SYSTEM tablespace to 
upgrade. If you run out of space during the upgrade, then you will need to 
perform the upgrade again. 

The following SQL statement illustrates how to add more space to a tablespace:

ALTER TABLESPACE SYSTEM
   ADD DATAFILE ’C:\ PATH/HOME/USER1/MOUNTPOINT/ORADATA/DB1/SYSTEM02.DBF’
   SIZE 20M;

6. Determine the files that you will back up in Step 9 in the next section (when 
performing a full backup) by issuing the following SQL statements:

SPOOL V8FILES.LOG;
SELECT MEMBER FROM V$LOGFILE;
SELECT NAME FROM V$DATAFILE;
SELECT VALUE FROM V$PARAMETER WHERE NAME = 'CONTROL_FILES';
SPOOL OFF;

The V8FILES.LOG spool file lists all of the files that you must back up in Step 9 
in the next section.
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Prepare the Cluster for Upgrade
To prepare the cluster for the new version of the Oracle8i Enterprise Edition 
software, perform the following steps on each node in the cluster:

1. Shut down the Oracle8 database cleanly using the SHUTDOWN NORMAL or 
SHUTDOWN IMMEDIATE command; do not use SHUTDOWN ABORT. The 
Oracle8 source database must be shut down cleanly; therefore, no redo 
information or uncommitted transactions can remain. 

C:> SVRMGRL
SVRMGR> CONNECT INTERNAL
SVRMGR> SHUTDOWN IMMEDIATE

2. Ensure all version 8 services are shutdown, including the OracleCMService 
service:

a. Double-click the Services icon in the Control Panel window.

The Services dialog box appears.

b. Select an Oracle service.

c. Click Stop to stop a service.

3. Change all the version 8 OSDs including the OracleCMService service to 
Manual startup:

a. Double-click the corresponding version 8 OSD and the OracleCMService 
service. The Services dialog box appears.

b. Click Manual in the Startup Type group box.

c. Click OK to dismiss the Services dialog box.

d. Click Close in the Services dialog box.

4. Shut down the version 8 OSD layer, as described in your vendor 
documentation. In most cases, you can use the same procedure as stopping an 
Oracle service, described in Step 2 
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5. Rename the OSD key under HKEY_LOCAL_
MACHINE\SOFTWARE\ORACLE to OSD80 using the registry editor, 
REGEDIT. OSD80 acts as a temporary storage for the version 8 OSD layer, 
which will be used later in the upgrade process.

To start the registry:

a. Choose Start > Run, enter REGEDIT in the Open field, and click OK.

The Registry Editor window appears.

b. Right-click to rename the OSD key.

6. Install the version 8.1 OSD layer, being sure not to overwrite the old version 8 
OSD files. See your vendor documentation for further information. 

7. Start the version 8.1 OSD layer, as described in your vendor documentation. 
Perform diagnostics on the clusterware as described in your vendor 
documentation. 

8. Backup raw partitions using OCOPY. Enter the following syntax: 

C:\> OCOPY \\.\PHYSICALDRIVEN NEW_FILE
where:

■ PHYSICALDRIVE is the physical drive that holds a single raw database file

■ N is the number(s) representing each of the physical drives in the system

■  NEW_FILE is the name and location of the backup copy

For example, to backup the logical partition for a system tablespace to a file, 
enter:

C:\> OCOPY \\.\OPS_SYSTEM1 OPS_SYSTEM1

Use your existing partitions and symbolic link names. Oracle Corporation 
recommends you backup logical partitions to files with the same name. For 
example, backup \\.\OPS_SYSTEM1 to a file named OPS_SYSTEM1.

See:    Oracle8i Administrator’s Guide for Windows NT, Chapter 11, 
Backing Up and Recovering Database Files, on using OCOPY.
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9. Perform a full offline backup of the database. Make sure you back up the files 
listed in the V8FILES.LOG spool file that you generated in Step 6 on page 2-32.

10. Exit Server Manager.

11. Deinstall your current release of Oracle if both of the following conditions are 
true:

■ You are upgrading from a previous 8.1 release.

■ You plan to use the same Oracle home for your current release and the new 
release to which you are upgrading.

If you plan to use separate Oracle home directories for your current release and 
the new release to which you are upgrading, then you do not need to deinstall 
your current release.

Caution: If you encounter any problems with the upgrade, then 
you will need to restore the database from this backup. Therefore, 
make sure you back up your database now as a precaution.

See: Oracle8i Backup and Recovery Guide for more information 
about backing up a release 8.1 database, or see Oracle8 Backup and 
Recovery Guide for information about backing up a release 8.0 
database.

Note: If you are upgrading from an 8.0 release, then you must 
install the new 8.1 release in an Oracle home separate from the 8.0 
release. However, if you are upgrading from a previous 8.1 release, 
then this restriction does not apply, and you can install the new 
release into the same Oracle home as the previous release if you 
wish.
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Install Release 8.1 Oracle8i Enterprise Edition
During installation, software components are installed on the node from which 
Oracle Universal Installer is run and pushed to the selected nodes in the cluster. The 
Oracle Universal Installer installs Oracle Parallel Server only if a cluster is detected.

To install, perform the following steps:

On one node, follow from Step 1, on page 2-10, to Step 8 on page 2-13, to install the 
Release 8.1 Oracle8i Enterprise Edition. 

Perform Post-Installation Steps
To prepare the cluster for the upgrade process, perform the following steps:

1. Shut down and restart your computer.

2. Change the OracleCMService and the OracleServiceSID services to Manual 
startup:

a. Double-click the Oracle service. The Services dialog box appears.

b. Click Manual in the Startup Type group box.

c. Click OK to dismiss the Services dialog box.

d. Click Close in the Services dialog box.

3. Make sure the new release 8 OSD layer is running on each node in the cluster.

4. Perform the following steps on the node from which you intend to run the 
upgrade scripts:

a. Start the OracleCMService and the OracleServiceSID services:

1. Double-click the Services icon in the Control Panel window. The Services 
dialog box appears.

2. Select an Oracle service.

3. Click Start.

4. Click Close to dismiss Services dialog box.

b. Set the Oracle home path to the new Oracle8i Oracle home path with a tool 
such as the Oracle Home Selector:

1. Choose Start > Programs > Oracle Installation Products > Oracle Home 
Selector. 

2. Select the Oracle8i home from the drop-down list. 
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Upgrade the Database Manually
Complete the following steps to upgrade:

1. Stop the Oracle8 service OracleServiceSID of the database you are upgrading, 
where SID is the instance name. For example, if your SID is ORCL:

a. Double-click the Services icon in the Control Panel window. 

The Services dialog box appears.

b. Select OracleServiceORCL.

c. Click Stop.

d. Click Close to dismiss Services dialog box.

2. Delete the Oracle service at the MS-DOS command prompt using ORADIM. 
The following table lists the MS-DOS command to run for each Oracle8i release:

For example, if your Oracle release is release 8.1.5 and your SID is ORCL, 
then enter the following at the MS-DOS command prompt:

C:\> ORADIM -DELETE -SID ORCL

Oracle Release... Enter at the MS-DOS Command Line...

8.0 C:\> ORADIM80 -DELETE -SID SID

8.1 C:\> ORADIM -DELETE -SID SID
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3. Create the Oracle8i database service at the MS-DOS command prompt:

C:\> ORADIM -NEW -SID SID -INTPWD PASSWORD -MAXUSERS USERS 
     -STARTMODE AUTO -PFILE ORACLE_HOME\DATABASE\INITSID.ORA 

This syntax includes the following variables: 

For example, if your SID is ORCL, your PASSWORD is TWxy579, the 
maximum number of USERS is 10, and the ORACLE_HOME directory is 
C:\ORA81, then enter the following command:

C:\> ORADIM -NEW -SID ORCL -INTPWD TWxy579 -MAXUSERS 10 
     -STARTMODE AUTO -PFILE C:\ORA81\DATABASE\INITORCL.ORA 

4. On all nodes, copy configuration files to a location outside of the old Oracle 
home:

a. If your initialization parameter file resides within the old environment’s 
Oracle home, then copy it to a location outside of the old environment’s 
Oracle home. By default Oracle looks for the initialization parameter file in 
ORACLE_HOME\DATABASE. The initialization parameter file can reside 
anywhere you wish, but it should not reside in the old environment’s 
Oracle home after you upgrade to the new release.

b. If your initialization parameter file has an IFILE (include file) entry and the 
file specified in the IFILE entry resides within the old environment’s Oracle 
home, then copy the file specified by the IFILE entry to a location outside of 
the old environment’s Oracle home. The file specified in the IFILE entry has 
additional initialization parameters.

SID is the same SID name as the SID of the database you are 
upgrading.

PASSWORD is the password for the new release 8.1 database instance. This 
is the password for the INTERNAL user. The -INTPWD option 
is not required. If you do not specify it, then operating system 
authentication is used, and no password is required. 

USERS is the maximum number of users who can be granted SYSDBA 
and SYSOPER privileges.

ORACLE_HOME is the release 8.1 Oracle home directory. Ensure that you 
specify the full pathname with the -PFILE option, including 
drive letter of the Oracle home directory.
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c. If you have a password file that resides within the old Oracle home, then 
move or copy the password file to the Oracle8i Oracle home. The default 
password file is ORACLE_HOME\DATABASE\PWDSID.ORA. Edit the file 
specified in the IFILE entry in the same way you edited the initialization 
parameter file in the previous steps a and b.

d. If your INITDB_NAME.ORA file resides within the old environment’s 
Oracle home, then move or copy the INITDB_NAME.ORA file to a location 
outside of the old environment’s Oracle home.

5. On all nodes, adjust the initialization parameter file for use with the new 
release.

a. Remove obsolete parameters and adjust changed parameters. Certain 
initialization parameters are obsolete in the new 8.1 release. Remove all 
obsolete parameters from any initialization parameter file that will start a 
new release 8.1 instance. Obsolete parameters may cause errors. Also, alter 
any parameter whose syntax has changed in the new 8.1 release.

b. If you are updating snapshots automatically by using the JOB_QUEUE_
PROCESSES initialization parameter, set JOB_QUEUE_PROCESSES to 0 
(zero) during upgrading. Also, if you are using Advanced Queuing and 
have propagation schedules, then set both the JOB_QUEUE_PROCESSES 
and AQ_TM_PROCESSES initialization parameters to 0. After upgrading 
your database, you can reset it to use these parameters.

c. If the initialization parameter file contains an IFILE entry, then change the 
IFILE entry in the initialization parameter file to point to the new location 
you copied it.

d. Modify the INITDB_NAME.ORA file in the same way that you modified 
the initialization parameter file.

Make sure you save all of the files you modified after making these 
adjustments.

e. Set the PARALLEL_SERVER initialization parameter to FALSE. You can 
change it back to TRUE after the upgrade operation is complete.

See: Oracle8i Migration guide, Appendix B, "Changes to 
Initialization Parameters" for lists of new, renamed, and obsolete 
parameters, and Oracle8i Parallel Server Concepts and Administration 
for more information about obsolete Oracle Parallel Server 
initialization parameters.
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6. At the MS-DOS command prompt, change to the ORACLE_
HOME\RDBMS\ADMIN directory.

7. Start Server Manager and connect to the database instance as INTERNAL user. 

C:> SVRMGRL
SVRMGR> CONNECT INTERNAL

8. Run STARTUP RESTRICT:

SVRMGR> STARTUP RESTRICT

You may need to use the PFILE option to specify the location of your 
initialization parameter file.

You may see error messages listing obsolete initialization parameters. If so, then 
make a note of the obsolete initialization parameters and continue with the 
upgrade normally. Then, remove the obsolete initialization parameters the next 
time you shut down the database (Step 14).

9. Set the system to spool results to a log file for later verification of success:

SVRMGR> SPOOL CATOUTU.LOG

If you want to see the output of the script you will run on your screen, then you 
also can issue a SET ECHO ON statement:

SVRMGR> SET ECHO ON
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10. Run UOLD_RELEASE.SQL where OLD_RELEASE refers to the release you had 
installed prior to upgrading. See the table below to choose the correct script. 
Each script provides a direct upgrade from the release specified in the "Old 
Release" column. The "Old Release" is the release from which you are 
upgrading.

To run a script, enter the following:

SVRMGR> @UOLD_RELEASE.SQL

See: Oracle8i Migration guide,"Upgrade Paths" on page 7-2 for more 
information on the upgrade paths and scripts.

Old Release Run Script

8.0.1 Direct upgrade is not supported. 

8.0.2 Direct upgrade is not supported. 

8.0.3 U0800030.SQL

8.0.4 U0800040.SQL

8.0.4S Direct upgrade is not supported. 

8.0.5 U0800050.SQL

8.0.6 U0800060.SQL

8.1.1 Upgrading to the new release is not supported.

8.1.2 Upgrading to the new release is not supported.

8.1.3 Direct upgrade is not supported. 

8.1.4 Direct upgrade is not supported. 

8.1.5 U0801050.SQL

Note: If the old release you had installed prior to upgrading is not 
listed, see the README files in the new installation for the correct 
upgrade script to run.
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Make sure you follow these guidelines when you run the script:

■ You must use the version of the script supplied with new release 8.1 
installation.

■ You must run the script in the new release 8.1 environment.

■ You only need to run ONE script, even if your upgrade spans several 
releases. For example, if your old release was 8.0.4, then you need to run 
only U0800040.SQL.

The script you run creates and alters certain dictionary tables. It also runs the 
CATALOG.SQL and CATPROC.SQL scripts that come with the release to which 
you are upgrading, which create the system catalog views and all the necessary 
packages for using PL/SQL.

If you encounter any problems when you run the script, or any of the scripts in 
the remaining steps, then correct the causes of the problems and rerun the 
script. You can rerun any of the scripts described in this chapter as many times 
as necessary.

You may encounter a series of messages similar to the following during the 
upgrade:

ORA-00604: error occurred at eecursive SQL level 1
ORA-00001: unique constraint (SYSTEM.AQ$_QUEUES_CHECK) violated
ORA-06512: at "SYS.DBMS_AQADM", line 2023
ORA-06512: at line 2

You can ignore these messages.

11. Run CATPARR.SQL:

SVRMGR> @CATPARR.SQL

12. Set the PARALLEL_SERVER initialization parameter to TRUE. 

See: Oracle8i Migration guide, "Running Scripts" on page 1-11 for 
information about the types of errors to look for when you run a 
script.
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13. Turn off the spooling of script results to the log file:

SVRMGR> SPOOL OFF

Then, check the spool file and verify that the packages and procedures 
compiled successfully. You named the spool file CATOUTU.LOG. Correct any 
problems you find in this file.

If you specified SET ECHO ON, then you may want to SET ECHO OFF now:

SVRMGR> SET ECHO OFF

14. Run SHUTDOWN on the Oracle8i database: 

SVRMGR> SHUTDOWN IMMEDIATE

Executing this clean shutdown flushes all caches, clears buffers, and performs 
other DBMS housekeeping activities. These measures are an important final 
step to ensure the integrity and consistency of the newly upgraded Oracle8i 
database.

Also, if you encountered a message listing obsolete initialization parameters 
when you started the database in Step 8, then remove the obsolete initialization 
parameters from the initialization parameter file now.

Your database and Oracle Parallel Server are now upgraded to the new 8.1 
release.

Caution: Use SHUTDOWN NORMAL or SHUTDOWN 
IMMEDIATE. Do not use SHUTDOWN ABORT.

Caution: If you retain the old Oracle software, then never start the 
upgraded database with the old software. Only start the database 
with the executables in the new release 8.1 installation directory. 
Also, before you remove the old Oracle environment, make sure 
you relocate any data files in that environment to the new Oracle8i 
environment. See the Oracle8i Administrator’s Guide for information 
about relocating data files.
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Perform Post-Oracle8i Upgrade Steps
Perform the following steps to complete the upgrade for Oracle Parallel Server:

1. On the node from which you ran the upgrade scripts:

a. Stop the OracleCMService and the OracleServiceSID services:

1. Double-click the Services icon in the Control Panel window. The Services 
dialog box appears.

2. Select an Oracle8i service.

3. Click Stop.

4. Click Close to dismiss Services dialog box.

2. Set the Oracle home path to the new Oracle8i Oracle home path with a tool such 
as the Oracle Home Selector:

a. Choose Start > Programs > Oracle Installation Products > Oracle Home 
Selector. 

b. Select the Oracle8i home from the drop-down list. 

See: To upgrade additional components, such as Java and the 
Advanced Queuing (AQ) option, see "Upgrading Specific 
Components" in Oracle8i Migration guide. 
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Perform Post-Upgrade Tasks
Complete the post-upgrade procedures listed in the table below. These are 
described in the Oracle8i Migration guide, Chapter 8, "After Migrating or Upgrading 
the Database".

Post-Upgrade Tasks
Additional Task Performed after 
Upgrading from Version 8.0 or Version 8.1

■ Perform a complete backup of the production 
database.    

■ Change the password for the OUTLN user.

■ Copy LONGs to LOBs.

■ Check for bad date constraints.    

■ Adjust the initialization parameters SHARED_
POOL_SIZE and LARGE_POOL_SIZE in your 
initialization parameter file to avoid problems with 
parallel execution.

■ If you installed the Java option, install ODCI.JAR 
AND CARTRIDGESERVICES.JAR files.

■ Modify your LISTENER.ORA file.

■ Migrate or upgrade your standby database to 
Oracle Release 8.1.

■ Add new features as appropriate. It is not necessary 
to make any immediate changes to begin using your 
Oracle8i database. You may prefer to introduce 
these enhancements into your database and 
corresponding applications gradually. 

■ Develop new administrative procedures as needed.

■ Adjust your initialization parameter file for the new 
release.

■ Normalize filenames. 

■ Rebuild unusable function-based 
indexes.
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Multiple Oracle Homes
Oracle Parallel Server for Windows NT supports multiple Oracle homes, but all the 
Oracle homes must contain the same release of the Oracle8i Enterprise Edition and 
Oracle Parallel Server.

Windows NT requires that each node have only one copy of the vendor-supplied 
Operating System Dependent layer active.
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Creating Raw Devices

This chapter describes how to create the raw devices required by Oracle Parallel 
Server data files, control files and redo log files. These steps assume you have 
installed the vendor-supplied Operating System Dependent layer and performed 
diagnostics on the clusterware, as described in your vendor documentation.

Specific topics discussed are:

■ Raw Devices Overview

■ Disk Definition

■ Creating Raw Devices for Automatic or Manual Database Creation

■ Creating Raw Devices for the Oracle Database Configuration Assistant

■ Creating Raw Devices for Manual Database Creation

■ Creating Raw Devices for Manual Database Creation with a Current 
Configuration

See Also: This chapter is a supplement to the following guide: 
Oracle8i Parallel Server Setup and Configuration Guide, Chapter 2, 
"Pre-Installation".
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Raw Devices Overview
As Windows NT does not support a proper distributed file system, Oracle bypasses 
it by using raw devices. This allows nodes running different instances to access 
shared disks. Data files, redo log files, and control files are stored on the raw 
devices. The shared disks are then a collection of unformatted raw devices.

Raw devices are created on a disk that does not have a primary partition and has 
only one extended partition. Raw devices are created prior to installation and 
creating a database. 

Raw Devices   
A raw device is a portion of a physical disk that Oracle8i on Windows NT uses for 
its database files. Raw devices are not like regular file management systems. The 
information they store cannot be identified or accessed by users. The use of raw 
devices may improve disk I/O performance by 5% to 10% when compared with 
disk I/O to a partition with a file system on it.

A raw device is created when an extended partition is created and logical partitions 
are assigned to it without applying any formatting. The Windows NT Disk 
Administrator application allows you to create an extended partition on a physical 
drive.

Primary Partitions     
A primary partition is one into which you can install the files needed to load an 
operating system. It is usually formatted for a particular file system and is assigned 
a drive letter. There can be, at most, four primary partitions on a physical drive.

Note: You need to create raw devices if you are creating a 
database manually, or using the Oracle Database Configuration 
Assistant to create the files for the database. However, if you are 
using the Oracle Database Configuration Assistant, a precise 
number of raw devices must be set up.
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Extended Partitions
An extended partition points to raw space on the disk that can be assigned multiple 
logical partitions for the database files. An extended partition avoids the 
four-partition limit by allowing you to define large numbers of logical partitions to 
accommodate applications using Oracle8i on Windows NT. Logical partitions can 
then be given symbolic link names to free up drive letters. This makes Oracle 
Parallel Server on Windows NT more scalable.

The Disk Administrator window below shows two disks. Disk 1 has an extended 
partition:
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The following table describes the partitions on disk 0 and disk 1:

The data files, control files and redo log files must be created on the logical 
partitions.

Disk Definition       
Windows NT uses the following naming convention to define each disk drive it 
finds at startup, where m is the number of the physical drive, and n is a partition 
number (logical partition number) as shown in the Disk Administrator window:

\Device\Harddiskm\Partitionn

This disk... Contains...

Disk 0 Two primary partitions

Disk 1 An extended partition with nineteen logical partitions and 134 MB of 
free space (this disk device includes six physical disk drives)

Note: You can tell whether space is unpartitioned free space or 
free space within an extended partitions by the direction of the 
diagonal lines. Lines for free space within an extended partition 
display from top left to the bottom (\\), and lines for unpartitioned 
free space display from top right to the bottom (//).
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For example, the first drive on a system (normally the C: drive) has the following 
name:

\Device\Harddisk1\Partition0

The first logical drive (E:) defined on the second physical drive has the following 
name:

\Device\Harddisk2\Partition1

Physical Disk
A physical disk represents the entire disk. It points to 
\Device\Harddiskx\Partition0. Windows NT automatically creates a symbolic link 
name of \\.\PhysicalDriveX, where X is the number corresponding to your hard 
disk drive number in the Disk Administrator. The X matches the X in 
\Device\HarddiskX\Partition0. 

\\.\PhysicalDriveX is automatically defined by Windows NT for every hard disk 
in the machine. For example, a machine with three hard disks will have the 
following names defined by Windows NT: 

\\.\PhysicalDrive0 

\\.\PhysicalDrive1 

\\.\PhysicalDrive2 

Internally, these names expand to: 

\\.\PhysicalDrive0 = \Device\Harddisk0\Partition0 

\\.\PhysicalDrive1 =\Device\Harddisk1\Partition0 

\\.\PhysicalDrive2 =\Device\Harddisk2\Partition0 

Note: When the nodes are rebooted, the hard disk and partition 
names can change, and symbolic link names mapped to a different 
partition. However, the physical disk remains the same. The Oracle 
Object Link Manager, described in this chapter, tracks and updates 
the symbolic links, so that the links are mapped correctly after 
rebooting. 
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Partition0 is special in that it represents the entire physical disk regardless of any 
partitioning scheme on that disk. On all disks recognized by Windows NT, the Disk 
Administrator writes a signature on the first block of all disks. To avoid overwriting 
that block, Oracle skips the first block of a physical raw partition which is used for 
an Oracle data file.

Physical Partition Naming Conventions for Oracle Parallel Server     
Oracle Parallel Server adopts a special naming convention to distinguish physical 
partitions within an extended raw partition from files on a file system. The first 17 
characters of the name must be:

\\.\PhysicalDrive

Logical Partition
A logical partition is a partition created by the Disk Administrator that points to a 
drive other than \Device\Harddiskx\Partition0. Logical partitions are initially 
assigned names with drive letters (\\.\drive_letter:) and typically re-assigned 
symbolic link names (\\.\symbolic link name). 

For example, \\.\D: may be assigned a symbolic link name of \\.\ops_sys1. 
Regardless of whether a drive letter or symbolic link name is used, logical partitions 
are defined to represent a specific partition in a disk rather than the entire disk. 
Internally, these names may expand to: 

\\.\D:= \Device\Harddisk2\Partition1 

\\.\op_system1= \Device\Harddisk3\Partition2

 

Note: Oracle does not skip the first block of a logical raw partition 
used for an Oracle data file. 
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Physical Disk and Logical Partition Considerations
Please consider the following when deciding which raw partition to use:

■ Physical disks are automatically defined by Windows NT to represent the entire 
disk, and should never be defined by the user. 

■ Logical partitions need to be defined by the user to represent a specific partition 
in a disk. These partitions should be logical partitions or drives contained in an 
extended partition. They should never be defined as Partition0. 

■ Using an entire disk (Partition 0) for an Oracle data file and using a partition 
which occupies the entire disk for an Oracle data file is not the same thing. Even 
when a partition occupies the entire disk, there is still a small space on the disk 
that is not part of the partition. 

■ If you are using an entire disk for an Oracle data file (Partition 0), use the 
pre-defined physical raw names which Windows NT provides. 

■ Use a logical partition if you are using a specific partition and it occupies the 
entire disk.

■ If using a specific partition created with the Disk Administrator, define and use 
a symbolic link name rather than a logical partition number (even if it occupies 
the entire disk).

Frequently Asked Questions
Question: What is the impact if I have created logical partitions, but defined 
physical disk convention names for them. For example: 

\\.\PhysicalDrivesys1 = \Device\Harddisk2\Partition1 

\\.\PhysicalDriveusr1 =\Device\Harddisk3\Partition1 

Answer: An Oracle database will handle the data file using the physical disk 
convention, even though it really is a logical partition. This will not cause any 
data corruption or loss, as long as you continue using the physical disk naming 
conventions. Oracle Corporation recommends you convert to the logical 
partition at your earliest convenience. See "Compatibility Issues" on page 3-8.
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Question: What is the impact if I have created logical names representing 
Partition0. For example:

\\.\op_system1 = \Device\Harddisk1\Partition0 

Answer: This will pose severe problems, as the Disk Administrator typically 
writes a signature into the first block of every disk, and consequently may 
overwrite a portion of the data file header.

 

Question: How do I transfer the contents of any raw partition to a standard file 
system for backup purposes? 

Answer: Use the Oracle utility OCOPY to copy data to or from a raw partition 
for both physical and logical raw conventions. See "Compatibility Issues" on 
page 3-8 for further information.

Compatibility Issues
The physical and logical partition conventions are not compatible with one another 
due to the extra block that is skipped for physical raw conventions. This also means 
you cannot simply do an OCOPY from a physical disk to a logical partition, as the 
contents of these partitions are incompatible. 

To convert from a physical convention to a logical convention, you must: 

1. Perform a full database export to a (local) file system. 

2. Create logical partitions and define logical names for these partitions. 

3. Re-create the database using the new logical partitions. 

4. Perform the full database import to the newly created database. 

If your database installation uses physical disk conventions with logical partitions, 
Oracle Corporation recommends converting to the logical partition conventions at 
your earliest convenience using the steps above. 

Note: This may also cause data loss. Never use Partition0 with the 
logical partition convention. See "Compatibility Issues" on page 3-8 
for information on rebuilding your Oracle database with the proper 
conventions. 
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Creating Raw Devices for Automatic or Manual Database Creation 
The following sections describe how to create the raw devices for three types of 
configurations:

■ Creating Raw Devices for the Oracle Database Configuration Assistant

■ Creating Raw Devices for Manual Database Creation

■ Creating Raw Devices for Manual Database Creation with a Current 
Configuration

Creating Raw Devices for the Oracle Database Configuration Assistant
Using the Oracle Database Configuration Assistant on a clean machine is the 
preferred method to create a database for Oracle Parallel Server.

 To create the raw devices, perform the following steps: 

■ Step 1: Install Oracle Parallel Server Raw Devices Management Utilities

■ Step 2: Create an Extended Partition 

■ Step 3: Create Logical Partitions

■ Step 4: Assign Symbolic Link Names

Note: The Oracle Database Configuration Assistant requires a 
precise number of raw devices for the database files. See Oracle8i 
Parallel Server Setup and Configuration Guide, page 2-5, for the 
number of raw devices, the sizes of the raw partitions, and the 
symbolic link names necessary for Oracle Database Configuration 
Assistant files.
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Step 1: Install Oracle Parallel Server Raw Devices Management Utilities
To install the Oracle Parallel Server raw devices management utilities, perform 
the following tasks on one node of the cluster:

1. Create a temporary directory.

2. Insert the Oracle8i Enterprise Edition CD-ROM.

3. Copy the contents of the \OPS_PREINSTALL directory to the temporary 
directory you created.

 

4. Install ORACLEOBJSERVICE on all nodes of the cluster by entering the 
following command from the temporary directory you created:

C:\> ORACLEOBJSERVICE /INSTALL

This installs the ORACLEOBJSERVICE as an automatic startup type whenever 
you reboot. This service monitors symbolic link changes and updates all nodes 
when changes occur on one node.

To remove ORACLEOBJSERVICE, use the following command:

C:\> ORACLEOBJSERVICE /REMOVE

For more information about the install and remove options, use the following 
command: 

C:\> ORACLEOBJSERVICE /HELP

Note: If you plan to assign symbolic link names after installing 
Oracle8i Enterprise Edition and creating a database using the 
Oracle Database Configuration Assistant, do not perform the 
following step. The ORACLEOBJSERVICE is automatically 
installed.
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Step 2: Create an Extended Partition 
Extended partitions point to raw space on disk drives. Multiple logical partitions 
are created in these extended partitions.

Only one extended partition can be created per disk. You can use the free space in 
the extended partition to create multiple logical partitions or use all or part of it 
when creating volume sets or other kinds of volumes for fault-tolerance purposes.

 To create an extended partition, perform the following tasks:

1. Shut down all nodes except one of the nodes.

2. On the node that is up, choose Start > Programs > Administrative Tools > Disk 
Administrator.

The Disk Administrator window appears:

Note the lines display diagonally from top right to the bottom left, indicating 
unpartitioned devices.

3. Select an area of free space in an extended partition on a disk that is on the 
shared disk subsystem by clicking the mouse.

Oracle Corporation recommends you use the entire disk.
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4. Choose Partition > Create Extended.

The Disk Administrator displays the minimum and maximum sizes for the 
extended partition:

5. Use the default maximum size, then click OK.

The extended partition is created.

Note the lines now display diagonally from top left to bottom right, indicating 
the partition is an extended partition.

Step 3: Create Logical Partitions
Logical partitions are created on one node of the cluster. To create logical 
partitions in an extended partition:

 

Note: Changes you have made are not saved until you choose 
Commit Changes Now from the Partition menu or quit the Disk 
Administrator.

Note: Oracle Corporation recommends you do not create more 
than 120 logical partitions in an extended partition. 
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1. On one of the nodes, select an area of free space in an extended partition by 
clicking the mouse on it. 

2. Choose Partition > Create. 

The Disk Administrator window displays the minimum and maximum sizes for 
the logical partition.

3. Enter the size of the logical partition, then click OK. 

4. Repeat Steps 1-3 until you have the required number of logical partitions. 

5. Choose Partition > Commit Changes Now. 

A confirmation dialog appears, informing you changes have been made to the 
disk. 

6. Click Yes to acknowledge the message. 

A dialog box appears, informing you the disks have been updated successfully. 

7. Click OK. 

8. Choose Partition > Close. 

To make the changes visible, on all nodes of the cluster, choose Options > Refresh.

 

The hard disks that access the shared area may be different from node to node. The 
logical partitions, however, that reside on the hard disks must be identical on all 
nodes.

Note: You can modify file sizes later, but not the raw devices. File 
sizes cannot expand the size of the raw device.

Note: In previous releases, you needed to unassign drive letters. 
You no longer need to unassign drive letters. This release includes 
the utility, Oracle Object Link Manager, which automatically 
unassigns link names.
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For example, Node 1 may look like:
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Node 2 may look like:

On Node 1, the logical partition E is defined as \Device\Harddisk1\Partition1. On 
Node 2, it is defined as \Device\Harddisk2\Partition1. Even though these map to 
different disks, they map to the same space on the shared disk.

Step 4: Assign Symbolic Link Names
The Oracle8i Enterprise Edition CD-ROM contains ASCII files (in the \OPS_
PREINSTALL directory), with symbolic link names already associated with raw 
partitions for a two-node cluster, supporting a database type created with the 
Oracle Database Configuration Assistant. 

Note: Oracle Database Configuration Assistant requires at least 10 
logical partitions. 
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When the Oracle Database Configuration Assistant creates the database, it verifies 
that the symbolic link names to the extended partitions have been created and 
stores the files in the raw devices. The names of the partitions use the following 
format:

\\. \SYMBOLIC_LINK_NAME

The symbolic name uses the database name and the file type.

For example, you can create a symbolic link called OP_REDO1_1 to the second 
logical partition on the second physical disk:

OP_REDO1_1 \DEVICE\HARDDISK2\PARTITION2

where OP is the database name and REDO1_1 is the REDO log file.

This release includes a new utility, the Oracle Object Link Manager. Oracle Object 
Link Manager (GUIORACLEOBJMANAGER.EXE) is a GUI utility that enables you 
to assign the logical partitions symbolic link names. When you install Object Link 
Manager, a service named ORACLEOBJSERVICE is installed on each node. This 
service monitors symbolic link changes and updates all nodes when changes occur 
on one node.

To assign symbolic link names, perform the following tasks: 

1. Refer to the Oracle8i Parallel Server Setup and Configuration Guide, Chapter 2, 
"Pre-Installation", for the symbolic link names required for Oracle Database 
Configuration Assistant files. 

In addition, add additional entries for log files if your cluster contains more 
than two nodes or your node numbers are not 0 and 1.

2. Make sure the ORACLEOBJSERVICE is running on all nodes:

a. Double-click the Services icon in the Control Panel window. The Services 
dialog box appears.

b. Select ORACLEOBJSERVICE.

c. Click Start.

d. Click Close to dismiss Services dialog box.

3. To run the Object Link Manager, use the following command on one node in the 
cluster:

C:> GUIORACLEOBJMANAGER.EXE
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The Object Link Manager appears. 

4. To add a mapping:

a. Select the row containing the partition that you want to assign a link name.

b. Click on the highlighted row to invoke the Edit window. 

c. Enter the new link name required for the Oracle Database Configuration 
Assistant file in the New Link Name column. For example, if the database 
name is OP, add OP_SYSTEM1 for the name of the SYSTEM tablespace data 
file.

d. Press Enter.

Repeat steps a to d for any additional edits.
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e. Choose Options > Commit to save all changes to disk. 

f. Verify all mappings are correct using Object Link Manager. 

5. On all nodes in the cluster, use the Object Link Manager to verify that symbolic 
links are correct. If you make any changes, choose the Commit menu item.

The logical partitions and their symbolic links appear on the node from which the 
Oracle Object Manager application is run. Link names may appear in upper case; 
however, the names are case insensitive.

To force all active nodes to re-synchronize the links, choose Options > Sync Nodes. 
Run the Object Link Manager on all nodes to refresh the links.

You do not need to reboot after making changes. However, if a node is down, it is 
automatically updated when you reboot. Rebooting also generates a log file, 
OOBJSERVICE.LOG in the directory where you installed the Oracle Object Service.

Note: If you create or remove a partition, you need to reassign 
links by rerunning the Oracle Object Link Manager on the node you 
made the disk configuration.
3-18 Oracle Parallel Server Administrator’s Guide for Windows NT



Creating Raw Devices for Manual Database Creation
Creating Raw Devices for Manual Database Creation 
Use this method to create raw devices for manual database creation on a machine 
that does not contain a previous installation of Oracle Parallel Server on raw 
devices.

Step 1: Install Oracle Parallel Server Raw Devices Management Utilities
To install the raw devices management utilities, perform the following tasks on 
one node of the cluster:

1. Create a temporary directory.

2. Insert the Oracle8i Enterprise Edition CD-ROM.

3. Copy the contents of the \OPS_PREINSTALL directory to the temporary 
directory you created. 

4. Install ORACLEOBJSERVICE by entering the following command from the 
temporary directory you created:

C:\> ORACLEOBJSERVICE /INSTALL

This installs the ORACLEOBJSERVICE as an automatic startup type whenever 
you reboot. This service monitors symbolic link changes and updates all nodes 
when changes occur on one node.

To remove ORACLEOBJSERVICE, use the following command:

C:\> ORACLEOBJSERVICE /REMOVE

For more information about the install and remove options, use the following 
command: 

C:\> ORACLEOBJSERVICE /HELP

Step 2: Create an Extended Partition 
Extended partitions point to raw space on disk drives. Multiple logical partitions 
are created in these extended partitions.

Note: Do not run ORACLEOBJSERVICE before using the 
EXPORTSYMLINKS utility described in Step 3. 
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Only one extended partition can be created per disk. You can use the free space in 
the extended partition to create multiple logical partitions or use all or part of it 
when creating volume sets or other kinds of volumes for fault-tolerance purposes.

You will need to create a logical partition for each log file, control file, and data file 
associated with the database. The number of raw devices created depends on the 
number of the data files, redo log files and control files you plan to create. Oracle 
Corporation recommends a logical partition of 100 MB. 

To create an extended partition, perform the following tasks:

1. Shut down all nodes except one of the nodes.

2. On the node that is up, choose Start > Programs > Administrative Tools > Disk 
Administrator.

The Disk Administrator window appears:

Note the lines display diagonally from top right to the bottom left, indicating 
unpartitioned devices.
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3. Select an area of free space in an extended partition on a disk that is on the 
shared disk subsystem by clicking the mouse.

Oracle Corporation recommends you use the entire disk.

4. Choose Partition > Create Extended...

The Disk Administrator displays the minimum and maximum sizes for the 
extended partition:

5. Use the default maximum size, then click OK.

The extended partition is created.

Note the lines now display diagonally from top left to bottom right, indicating 
the partition is an extended partition.

Step 3: Create Logical Partitions
Logical partitions are created on one node of the cluster. To create logical 
partitions in an extended partition:

 

Note: Changes you have made are not saved until you choose 
Commit Changes Now from the Partition menu or quit the Disk 
Administrator.

Note: Oracle Corporation recommends you do not create more 
than 120 logical partitions in an extended partition. 
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1. On one of the nodes, select an area of free space in an extended partition by 
clicking the mouse on it. 

2. Choose Partition > Create. 

The Disk Administrator window displays the minimum and maximum sizes for 
the logical partition.

3. Enter the size of the logical partition, then click OK. 

4. Repeat Steps 1-3 until you have the required number of logical partitions. 

5. Choose Partition > Commit Changes Now. 

A confirmation dialog appears, informing you changes have been made to the 
disk. 

6. Click Yes to acknowledge the message. 

A dialog box appears, informing you the disks have been updated successfully. 

7. Click OK. 

8. Choose Partition > Close. 

To make the changes visible, on all nodes of the cluster, choose Options > Refresh.

 

The hard disks that access the shared area may be different from node to node. The 
logical partitions, however, that reside on the hard disks must be identical on all 
nodes.

Note: You can modify file sizes later, but not the raw devices. File 
sizes cannot expand the size of the raw device.

Note:: In previous releases, you needed to unassign drive letters. 
You no longer need to unassign drive letters. This release includes 
the utility Oracle Object Link Manager, which automatically 
unassigns link names.
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For example, Node 1 may look like:
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Node 2 may look like:

On Node 1, the logical partition E is defined as \Device\Harddisk1\Partition1. On 
Node 2, it is defined as \Device\Harddisk2\Partition1. Even though these map to 
different disks, they map to the same space on the shared disk.

Step 4: Assign Symbolic Link Names
This release includes a new utility, the Oracle Object Link Manager. Oracle Object 
Link Manager (GUIORACLEOBJMANAGER.EXE) is a GUI utility that enables you 
to assign the logical partitions symbolic link names. When you install Object Link 
Manager, a service named ORACLEOBJSERVICE is installed on each node. This 
service monitors symbolic link changes and updates all nodes when changes occur 
on one node.

To assign symbolic link names, you create a .TBL file and import it into the Oracle 
Object Link Manager. Before you proceed, make sure you know the partition sizes 
and the symbolic link names you want to assign to them. 

To assign symbolic links: 

Use the EXPORTSYMLINKS utility to generate a list of device names and create a 
file named SYMMAP.TBL. 
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1. Use the following command line syntax:

For example: 

EXPORTSYMLINKS /f:MYLINKS.TBL

The following table shows a sample disk layout.

 

2. Modify the SYMMAP.TBL file by adding your own symbolic link names to their 
logical partition assignments.

 

/f:filename If this parameter is not used, the EXPORTSYMLINKS 
utility exports the symbolic link mappings to the 
SYMMAP.TBL file in the current directory. Otherwise, 
the utility exports the symbolic link mappings to the 
file named filename.

Symbolic Name Raw Device Size (MB)

system1 \Device\Harddisk2\Partition1 11.98

users1 \Device\Harddisk2\Partition1 11.98

temp1 \Device\Harddisk2\Partition1 11.98

rbs1 \Device\Harddisk2\Partition1 11.98

indx1 \Device\Harddisk2\Partition2 11.98

tools1 \Device\Harddisk2\Partition2 11.98

drsys1 \Device\Harddisk2\Partition2 11.98

control1 \Device\Harddisk2\Partition3 11.98

control2 \Device\Harddisk2\Partition3 11.98

redo1_1 \Device\Harddisk2\Partition3 11.98

redo1_2 \Device\Harddisk2\Partition3 11.98

Note:  If you add or delete partitions, you must use 
EXPORTSYMLINKS to export the SYMMAP.TBL file again on the 
node you configured the disk. The .TBL file will not be valid.
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3. Import the SYMMAP.TBL file into Oracle Object Link Manager with the 
IMPORTSYMLINKS.EXE utility. 

The IMPORTSYMLINKS utility reads a .TBL file and marks the hard disk 
partitions with the symbolic link names. Use the following command line 
parameters:

For example: 

IMPORTSYMLINKS /f:C:\TEMP\MYLINKS.TBL

4. Use the Object Link Manager to select and update the symbolic mappings. 

a. Start the ORACLEOBJSERVICE by entering the following command on all 
nodes in the cluster:

C:\> NET START ORACLEOBJSERVICE

b. To run the Object Link Manager, use the following command on one node 
in the cluster:

C:> GUIORACLEOBJMANAGER.EXE

/f:filename If this parameter is not used, the IMPORTSYMLINKS 
utility uses the symbolic link mappings in the 
SYMMAP.TBL file. Otherwise, the utility uses the 
symbolic link mappings in the file named filename.

/8i Use this parameter to update all active nodes.

Note: IMPORTSYMLINKS detects duplicate names and does not 
import mappings if duplicates are present.
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The Object Link Manager appears. 

5. To add or rename a mapping:

a. Select the row containing the partition that you want to assign a link name.

b. Click on the highlighted row to invoke the Edit window. 

c. Enter the new link name in the New Link Name column. For example, if the 
database name is OP, add OP_SYSTEM1 for the name of the SYSTEM 
tablespace data file.

d. Press Enter.

Repeat steps a to d for any additional edits.
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e. Choose Options > Commit to save all changes to disk. 

f. Verify all mappings are correct using Object Link Manager. 

6. On all nodes in the cluster, start the ORACLEOBJSERVICE

a. Double-click the Services icon in the Control Panel window. 

The Services dialog box appears.

b. Select ORACLEOBJSERVICE.

c. Click Start.

d. Click Close to dismiss Services dialog box.

7. On all nodes in the cluster, use the Object Link Manager to verify that symbolic 
links are correct. 

The logical partitions and their symbolic links appear on the node from which 
the Oracle Object Manager application is run. Link names may appear in upper 
case; however, the names are case insensitive.

To force all active nodes to re-synchronize the links, choose Options > Sync Nodes. 
Run the Object Link Manager on all nodes to refresh the links.

Note: If you create or remove a partition, you need to reassign 
links by rerunning the Oracle Object Link Manager on the node you 
made the disk configuration.
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You do not need to reboot after making changes. However, if a node is down, it is 
automatically updated when you reboot. Rebooting also generates a log file, 
OOBJSERVICE.LOG in the directory where you installed the Oracle Object Service.

Creating Raw Devices for Manual Database Creation with a Current 
Configuration

Use the method described in this section to create raw devices for manual database 
creation if you have a current configuration.

To create the raw devices, perform the following steps: 

■ Backup Raw Partitions

■ Step 1: Install Oracle Parallel Server Raw Devices Management Utilities

■ Step 2: Create an Extended Partition 

■ Step 3: Create Logical Partitions

■ Step 4: Assign Symbolic Link Names

Backup Raw Partitions
To back up the raw partitions, perform the following tasks:

1. Start the OSD layer, as described in your vendor documentation. Perform 
diagnostics on the clusterware as described in your vendor documentation. 

2. Backup raw partitions using OCOPY. Enter the following syntax: 

C:\> OCOPY \\.\PHYSICALDRIVEN NEW_FILE

where:

■ PHYSICALDRIVE is the physical drive that holds a single raw database file

■ N is the number(s) representing each of the physical drives in the system

■  NEW_FILE is the name and location of the backup copy
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For example, to backup the logical partition for a system tablespace to a file, 
enter:

C:\> OCOPY \\.\OPS_SYSTEM1 OPS_SYSTEM1

Use your existing partitions and symbolic link names. Oracle Corporation 
recommends you backup logical partitions to files with the same name. For 
example, backup \\.\OPS_SYSTEM1 to a file named OPS_SYSTEM1.

Step 1: Install Oracle Parallel Server Raw Devices Management Utilities
To install the raw devices management utilities, perform the following tasks on 
one node of the cluster:

1. Create a temporary directory.

2. Insert the Oracle8i Enterprise Edition CD-ROM.

3. Copy the contents of the \OPS_PREINSTALL directory to the temporary 
directory you created. 

4. Install ORACLEOBJSERVICE by entering the following command from the 
temporary directory you created:

C:\> ORACLEOBJSERVICE /INSTALL

This installs the ORACLEOBJSERVICE as an automatic startup type whenever 
you reboot. This service monitors symbolic link changes and updates all nodes 
when changes occur on one node.

To remove ORACLEOBJSERVICE, use the following command:

C:\> ORACLEOBJSERVICE /REMOVE

For more information about the install and remove options, use the following 
command: 

C:\> ORACLEOBJSERVICE /HELP

See:  Oracle8i Administrator’s Guide for Windows NT, Chapter 11, 
Backing Up and Recovering Database Files, on using OCOPY.

Note: Do not run ORACLEOBJSERVICE before using the 
EXPORTSYMLINKS utility described in Step 3. 
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Step 2: Create an Extended Partition
Follow the steps in the previous section, on page 3-19, if you need to create an 
extended partition for additional logical partitions. 

Step 3: Create Logical Partitions
Follow the steps in the previous section, on page 3-24, to create additional logical 
partitions in the extended partition.

Step 4: Assign Symbolic Link Names
This release includes a new utility, the Oracle Object Link Manager. Oracle Object 
Link Manager (GUIORACLEOBJMANAGER.EXE) is a GUI utility that enables you 
to assign the logical partitions symbolic link names. When you install Object Link 
Manager, a service named ORACLEOBJSERVICE is installed on each node. This 
service monitors symbolic link changes and updates all nodes when changes occur 
on one node.

To verify and assign symbolic link names, use the EXPORTSYMLINKS utility to 
generate a list of device names and create a file named SYMMAP.TBL. If valid 
symbolic mappings exist in a .TBL file, you can also import that file.

To use the EXPORTSYMLINKS utility:

1. Use the following command line syntax:

For example: 

EXPORTSYMLINKS /f:MYLINKS.TBL

/f:filename If this parameter is not used, the EXPORTSYMLINKS 
utility exports the symbolic link mappings to the 
SYMMAP.TBL file in the current directory. Otherwise, 
the utility exports the symbolic link mappings to the 
file named filename.
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The following table shows a sample disk layout.

2. Only links mapped to a valid shared disk and partition are exported. Duplicate 
symbolic links are indented. Check the SYMMAP.TBL file carefully for the 
following:

■ Duplicate symbolic link names

■ Symbolic link names point to partitions which are not logical partitions

■ Symbolic link names point to logical partitions which are not part of a valid 
file system

■ Symbolic link names are missing 

If any of these issues exist, see the Troubleshooting section in Chapter 4, 
"Managing Raw Devices" before proceeding.

3.  Modify the SYMMAP.TBL file as needed.

Symbolic Name Raw Device Size (MB)

system1 \Device\Harddisk2\Partition1 11.98

users1 \Device\Harddisk2\Partition1 11.98

temp1 \Device\Harddisk2\Partition1 11.98

rbs1 \Device\Harddisk2\Partition1 11.98

indx1 \Device\Harddisk2\Partition2 11.98

tools1 \Device\Harddisk2\Partition2 11.98

drsys1 \Device\Harddisk2\Partition2 11.98

control1 \Device\Harddisk2\Partition3 11.98

control2 \Device\Harddisk2\Partition3 11.98

redo1_1 \Device\Harddisk2\Partition3 11.98

redo1_2 \Device\Harddisk2\Partition3 11.98

Note:  If you add or delete partitions, you must use 
EXPORTSYMLINKS to export the SYMMAP.TBL file again on the 
node you reconfigured the disk. The .TBL file will not be valid.
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4. Import the SYMMAP.TBL file into Oracle Object Link Manager with the 
IMPORTSYMLINKS.EXE utility. 

The IMPORTSYMLINKS utility reads a .TBL file and marks the hard disk 
partitions with the symbolic link names. Use the following command line 
parameters:

For example: 

IMPORTSYMLINKS /f:C:\TEMP\MYLINKS.TBL

5. Use the Object Link Manager to select and update the symbolic mappings. 

a. Start the ORACLEOBJSERVICE by entering the following command on all 
nodes in the cluster:

C:\> NET START ORACLEOBJSERVICE

b. To run the Object Link Manager, use the following command on one node 
in the cluster:

C:> GUIORACLEOBJMANAGER.EXE

/f:filename If this parameter is not used, the IMPORTSYMLINKS 
utility uses the symbolic link mappings in the 
SYMMAP.TBL file. Otherwise, the utility uses the 
symbolic link mappings in the file named filename.

/8i Use this parameter to update all active nodes.

Note: IMPORTSYMLINKS detects duplicate names and does not 
import mappings if duplicates are present. 
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The Object Link Manager appears. 

6. To add or rename a mapping:

a. Select the row containing the partition that you want to assign a link name.

b. Click on the highlighted row to invoke the Edit window. 

c. Enter the new link name in the New Link Name column. For example, if the 
database name is OP, add OP_SYSTEM1 for the name of the SYSTEM 
tablespace data file.

d. Press Enter.

Repeat steps a to d for any additional edits.
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e. Choose Options from the menu and then choose the Commit menu item to 
save all changes to disk. 

f. Verify all mappings are correct using Object Link Manager. 

7. On all nodes in the cluster, start the ORACLEOBJSERVICE

a. Double-click the Services icon in the Control Panel window. The Services 
dialog box appears.

b. Select ORACLEOBJSERVICE.

c. Click Start.

d. Click Close to dismiss Services dialog box.

8. On all nodes in the cluster, use the Object Link Manager to verify that symbolic 
links are correct. 

The logical partitions and their symbolic links appear on the node from which 
the Oracle Object Manager application is run. Link names may appear in upper 
case; however, the names are case insensitive.

To force all active nodes to re-synchronize the links, choose Options > Sync Nodes 
menu item. Run the Object Link Manager on all nodes to refresh the links.

You do not need to reboot after making changes. However, if a node is down, it is 
automatically updated when you reboot. Rebooting also generates a log file, 
OOBJSERVICE.LOG in the directory where you installed the Oracle Object Service.

Note: If you create or remove a partition, you need to reassign 
links by rerunning the Oracle Object Link Manager on the node you 
made the disk configuration.
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Managing Raw Devices

This chapter describes additional command line utilities that allow you to manage 
raw devices. Specific topics discussed are:

■ Raw Devices Management Utilities

■ Reformat an Entire Disk

■ Remove All Drive Letters

■ Initialize All Space on a Logical Partition

■ Create Logical Drives

■ Review Disk Layout

■ Troubleshooting
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Raw Devices Management Utilities
The raw devices management utilities work only with raw devices set up for 
Oracle8i applications. The raw devices and their partitions have the following 
characteristics: 

■ Must contain only one extended partition

■ Must not contain a valid NTFS or FAT partition

■ Must not contain a primary partition

Before you run these utilities, it is assumed you have created logical partitions. If 
you need to create a logical partition to add a symbolic link name, use the 
CRLOGDR utility or Windows NT Disk Administrator. For the steps to create 
logical partitions, see page 3-11.

Reformat an Entire Disk
The DELETEDISK utility reformats an entire disk and deletes the contents. It uses 
the following command line parameters:

For example, if you want to delete all the logical partitions on disk 2, use the 
following command: 

C:> DELETEDISK /d2 

After you run the DELETEDISK utility, you must run Disk Administrator on all 
nodes to reinitialize the disk signatures. 

/ddrive_number Required.You must specify this parameter where drive_
number is the number of the disk.

/q Optional. Quiet mode. You are not prompted for 
format confirmation.

/fsd Optional. Use this parameter to format a hard disk 
even if it contains a valid File System partition.
4-2 Oracle Parallel Server Administrator’s Guide for Windows NT



Initialize All Space on a Logical Partition
To run Disk Administrator:

1. Choose Start > Programs > Administrative Tools > Disk Administrator on all 
the nodes.

On all nodes a dialog box appears, informing you the disk configuration has 
been detected. If the dialog box does not appear, the disk configuration may still 
have changed. 

2. Click OK.

Remove All Drive Letters 
The LETTERDELETE utility removes all drive letters from partitions and updates 
the disk key registry to disable reboot mappings. Use this utility when drive letters 
are reassigned after partitions are created, and for troubleshooting. You do not need 
to specify any command line parameters. 

For example: 

C:> LETTERDELETE

Initialize All Space on a Logical Partition
The LOGPARTFORMAT utility initializes all space in a logical partition to zero and 
removes the symbolic link name. Use this utility if you have old information in the 
control files. The only parameter you need to specify is the name of the logical 
partition that you want to use. For example if you want to initialize all space on the 
\\.\ops_db12 partition to zero, use the following command: 

C:> LOGPARTFORMAT \\.\OPS_DB12 
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Create Logical Drives
The CRLOGDR utility enables you to create and delete logical drives and their asso-
ciated symbolic names on a disk that does not have a primary partition and has 
only one extended partition.

The utility supports eight parameters, as follows:

Usage Notes
To avoid re-sequencing problems when the server reboots, Oracle Corporation 
recommends that you use the CRLOGDR utility only to: 

■ Remove logical drives from the end of the extended partition

■ Add logical drives to the end of the partition by specifying the offset of the last 
free space

Examples
The following examples show how to use CRLOGDR.

Example 1  
To create a logical drive of 300 MB on disk 3 with no symbolic name:

CRLOGDR /d3 /s 300

Example 2  
To create a logical drive of 100 MB on disk 3 with the symbolic name ’CONTROL1’:

CRLOGDR /d3 /s 100 /l CONTROL1

/d Zero indexed drive number (required parameter)

/s Logical drive size

/n Logical drive number

/o Free space offset from beginning of extended partition

/l Symbolic name

/r Removes logical drive or symbolic name

/p Print disk layout

/b Suppress banner
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Example 3  
To assign the symbolic name ’SYSTEM1’ to the previously created second logical 
drive (2):

CRLOGDR /d3 /n 2 /l SYSTEM1

Example 4  
To create a logical drive of 300 MB on disk 3 at offset 100 MB with no symbolic 
name:

CRLOGDR /d3 /s 300 /o 100

Example 5  
To remove the second logical drive on disk 3: 

CRLOGDR /d3 /r /n 2

Example 6  
To remove the symbolic name ’CONTROL1’ (there is no need to supply disk num-
ber):

CRLOGDR /r /l CONTROL1

Note: The offset /o parameter must be the starting offset of the 
free space.

Note: This command also removes the symbolic name associated 
with the drive.
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Review Disk Layout
You can review the disk layout by using the CRLOGDR utility’s print parameter 
(/p). To print the layout of disk 4, for example: 

CRLOGDR /d4 /p
Oracle Corporation. Copyright (c) 1998. All rights reserved. 
crlogdr - Version 1.0

  NUM        SIZE(MB)       SYMBOLIC NAME  TYPE      OFFSET(MB)    
    1             300          DSS_TABLES     6               0      
    2             300         OLTP_TABLES     6             300     
    3             300           PD_TPCB01     6             600     
    4             300           OLTP_INDX     6             900    
    5             300            OLTP_RBS     6            1200   
    6             300           PD_TPCB04     6            1500    
    7             200           OPS_RBS01     6            1800
*Free               5                  --    --            2000

Total Free Space: 5MB

The columns have the following significance: 

Column Description

NUM Logical drive number or free space.

SIZE Size of logical drive or free space. 

SYMBOLIC NAME Symbolic name associated with the drive, if any. Two hyphens 
(--) mean no symbolic name has been assigned to the drive. 

TYPE Type of partition, where 6 indicates a large MS-DOS partition 
and 7 indicates an NTFS partition. 

Note: Raw disk partitions have no file system.

OFFSET Offset of the partition from the beginning of the extended 
partition. 
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Troubleshooting

Mappings Do Not Appear
If mappings do not appear in the Oracle Object Link Manager, make sure the 
ORACLEOBJSERVICE is started on all nodes in the cluster. 

To start the service:

1. Double-click the Services icon in the Control Panel window. The Services dialog 
box appears.

2. Select ORACLEOBJSERVICE.

3. Click Start.

4. Click Close to dismiss Services dialog box.

General Troubleshooting
Some troubleshooting items are related to improper installation of the clusterware. 
Consult your hardware vendor documentation.

Unable to Start a Dedicated Server Process
Make sure ORACLESERVICESID and TNS LISTENER run under the same 
Windows NT account with the same user ID. 

Windows NT Disk Administrator Cannot Create Partitions
Most likely, an extended partition was not created. Follow the steps page 3-11, 
Create Logical Partitions in an Extended Partition, to first create the extended 
partition and the multiple logical partitions within the extended partition. 
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Symbolic Link Names in .TBL File Are Not Exported
Only symbolic link names mapped to a valid shared disk and partition are 
exported. If you are exporting a .TBL file with current mappings (the default name 
is SYMMAP.TBL), check the file carefully. 

The following table describes the problems you may encounter, and their solutions.

Problem Solution

Duplicate symbolic link 
names

Edit the .TBL file by deleting the second occurrence of the 
symbolic link name. The IMPORTSYMLINKS utility removes 
duplicate names for any devices.

Symbolic link names 
point to logical partitions 
which are not part of a 
valid file system

The raw devices and their partitions must not contain a valid 
NTFS or FAT partition. 

1. Use the Windows NT Disk Administrator to assign a drive 
letter. 

2. Verify that you do not want to use the partition. Most likely, 
the logical partition does not contain any valid data.

3. Use the LOGPARTFORMAT utility to delete the partition 
and file system. 

Symbolic link names 
point to partitions which 
are not logical partitions

The raw devices and their partitions must contain only one 
extended partition, and not a primary partition.

1. Use OCOPY to copy the partition data for every partition.

2. Verify that you do not want to use any logical partitions. 
Use the DELETEDISK utility to reformat the entire disk.

3. Run Disk Administrator to reinitialize the disk signatures.
4. Follow the steps page 3-29, Creating Raw Devices for 

Manual Database Creation with a Current Configuration. 
(You will need to create logical partitions within an 
extended partition.)

See: Backup Raw Partitions on page 3-29 on how to use OCOPY.

Symbolic link names are 
missing in the .TBL file.

Add symbolic link names to the .TBL file before exporting.
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Specific topics covered in this appendix are:

■ Understanding the 8.1.6 Database Directory Trees

■ Windows NT Directory Structure
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Understanding the 8.1.6 Database Directory Trees
When you install Oracle8i Enterprise Edition and the Oracle Parallel Server Option 
with the Typical installation option, all subdirectories are under a top level 
ORACLE_BASE that is of the form X:\ORACLE where X is any hard drive. If you 
install an OFA-compliant database using Oracle Universal Installer defaults, 
ORACLE_BASE is C:\ORACLE.

\ORACLE_HOME directories are located under ORACLE_BASE. The \ADMIN and 
\OPS directories are also located under ORACLE_BASE.

Windows NT Directory Structure
The following is the hierarchical directory tree of a sample OFA-compliant database 
for Oracle Parallel Server:

C:\ORACLE_BASE C:\ORACLE is the default ORACLE_
BASE directory 

\ORACLE_HOME \ORA81 is the name of the Oracle 
home by default

\BIN Subtree for Oracle binaries 

\NETWORK Subtree for Net8 configuration files, 
including TNSNAMES.ORA, 
LISTENER.ORA and SQLNET.ORA 

\OPS Files created by Oracle Database 
Configuration Assistant 

\OPSM \ADMIN subdirectory

\ADMIN Oracle Parallel Server OPS.SQL script 
and initialization parameter files for 
database creation  

\DATABASE This is a legacy directory from 
previous releases. It contains 
initialization files that point to the new 
directory location for the initialization 
parameter files, ORACLE_
BASE\ADMIN\
DB_NAME\PFILE.

. . . 

\ADMIN Subtree for Oracle Parallel Server 
database administration files 
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\DB_NAME DB_NAME database administration 
files for the instance identified by SID 

\ADHOC Ad hoc SQL scripts 

\ADUMP Audit files 

\ARCH Archived redo log files

\BDUMP Background process trace files 

\CDUMP Core dump files 

\CREATE Programs used to create the database 

\EXP Database export files 

\PFILE Initialization parameter files

\UDUMP User SQL trace files 
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